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Introduction

Who has never dreamed about creating his own game? Previously, developing a game required having
a good concept, but also advanced knowledge in programming. Even if you had in your possession all
of the other elements needed to create an extraordinary game, it was easy to get discouraged by the
mountain of technical knowledge normally needed. Luckily, the market evolved and more and more
tools became available to the user which could facilitate the task of game creation—but none of them,
until now, has given as much power and flexibility to the creator as Coldstone. With Coldstone the
user will be able to devote himself entirely to the content of his game and will be capable of achieving
his computer game dream.

What is Coldstone?

Imagine a set of powerful yet easy to use tools for constructing your very own stand-alone role
playing game... no rules... a completely blank sheet of paper on which to pen your masterpiece...
where what you can create is limited only by your imagination. This is exactly what Beenox, in
conjunction with Ambrosia Software, Inc., is bringing to you with the Coldstone game development
tool.

Coldstone is a role playing game construction kit that offers unprecedented power and ease of use,
allowing you to create professional, stand-alone games that are limited only by your imagination.
Unhindered by the complex details that Coldstone handles for you, your fantasy world will spring to
life as quickly as you can dream it up.

Any genre of game can be created: fantasy, sci-fi, modern, western gunslinging -- whatever you can
dream up! Coldstone isn't designed to just make just one style of game; in fact a space adventure
game with ships and planets could easily be done: Coldstone is that flexible. For an example of a
fantasy-style game created using Coldstone, check out Pillars of Garendall at:
 http://www.AmbrosiaSW.com/games/pog/.

Coldstone makes it possible to the user to create a game (or series of games) that can be modified by
the Coldstone editor and eventually be compiled as an independent application for Macintosh and/or
Windows. Compilation consists of gathering the elements of the game and transforming them into an
independent application which does not require that the end-user has Coldstone installed.
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First contact with Coldstone

When you start Coldstone for the first time, this dialog will appear:

You have two choices: create a new game or open an existing one. If it is the first time that you have
used Coldstone, it is strongly advised that you select the first option and quickly create a game with
the Coldstone Game Factory. This game has the principal advantage of being immediately playable (i.e.
all the basic elements necessary for the execution of a game are defined). You can start by adding or
modifying certain maps and see the results in order to familiarize yourself with Coldstone.
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Select the “Create a new game or plugin”. The Coldstone Game Factory dialog will appear. Click the
“Select…” button to choose where to save your new game and click the “Next” button. You will be
prompted to choose your game style.  Be sure to select the Medieval style and click on the “Next”
button again and work your way through the end.

Coldstone opens, deploying your arsenal of tools. The tips of the day window is also opened and will
be automatically opened whenever you launch Coldstone unless you deselect the option “Show tips at
startup” 1. Each time you start Coldstone, the last game you worked on will open automatically2.

You will notice the two principal windows immediately. They are the tool window and the game
browser which make it possible to add new elements and to navigate through those of the current
game respectively.

Coldstone tool window

Coldstone game browser

                                                
1 Tips of the day will remain accessible with the “Tips of the day” command in the “Tools” menu.
2 You can also change the current edited game with the “Change game …”  command of the “File” menu
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If you open the game folder in the Finder, you will notice that the content of the browser reflects
exactly the contents of the game folder. When you click on the arrow to the left of the folder icon,
this folder will display all its contents in the list exactly the same way that the Finder does. If you
double click on a folder, a file browser will open showing the contents of that folder.

Coldstone file browser

The file browser works the same way as the game browser except that it contains some additional
functions that we will discuss in the section “Working interface”. If you double-click on a file and
Coldstone supports that file (like the locations in the sample game) the corresponding editor will open,
displaying the contents of this file. However, if this file is not supported it will be opened by the
application which normally supports it. Thus, if you try to open an HTML document, for example, your
default web browser will start and display that document.
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Game elements

A Coldstone game is typically made up of 10 elements: maps, locations, events, items, non-player
characters (NPCs), races, classes, skill tables, spells and animations.

Maps
Maps make it possible to add environments in which the player can walk and discover things. The
player is represented by an icon or an animation that you choose and can walk freely in the accessible
zones of the map. When you create a map, you can specify the size of the map in tiles as well as the
dimensions of the tiles in pixels. You can thus create a map of the world with smaller tiles in order to
give the impression of a vast world or a city with larger tiles to increase the details of the graphics.
You must also define the access value of the tiles (where the player can and cannot go) and the
events that will occur when the player enters a tile.

Locations

Locations are the center of the game. The player must always be in a location because it's what will
determine what he sees on the screen. There exist several types of locations. One, for example, allows
you to display an image in which the player will be able to click in order to make something happen.
Another type of location is used to send the player to a map.

Events
An event is a group of actions that are executed one after the other. That way, you will be able to
display dialogs, make the player take different turns in the story line, play music, etc.

Items
Items represent everything that the player, other characters and shops have in their inventory. There
are many types of items: weapons, armor, shields, gloves, boots, belts, various objects (potions, etc.),
and special objects.

Non-player characters (NPCs)
Non-player characters (NPCs) represent all the people and creatures that you will encounter in an
adventure. They have their own individual battle characteristics and can also have objects in their
inventory as well as spells at their disposal. Each character has an artificial intelligence scheme
(which must be selected from a predefined list) that will determine how the character will behave in
battle. You can also create friendly NPCs (i.e. that will not attack you) by assigning them a stamina
value of 0. You can use this feature to create villagers for example.

Races
A race determines from which country, area, or clan a player comes. When the player starts a new
game, he can choose a race (you can disable this option if you want). A race modifies the base
statistics of the player. You could imagine that a race that comes from a very cold area of the north
has more resistance to cold than one that comes from the equator, for example.

Classes
A class represents the specialty of the player. Just like races, the player can choose a class when he
starts a new game (you can also disable this option if you want). Classes may modify the base
statistics of the player, and determine which spells and equipment the player can gain during his
adventures. For example, a warrior might have few magic capabilities, but could receive a bonus to his
basic strength.
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Skill tables
The more the player progresses in his adventure, the more experience he will acquire. Experience in
Coldstone is represented by a score that starts from zero and increases ad infinitum. A skill table
defines the amount of experience points needed to advance to the next level. When the player gains a
level, he gains additional stamina points and magic points. It is also possible to bind an event to a level
upgrade. Thus it would be possible to give a player a magic item (via an event) when he reached a
high enough level.

Spells
Spells can be used by the player or other characters in combat or elsewhere. Coldstone lets you define
your own magic system. A series of parameters enable you to define the cost in magic points, the
minimum level to be able to use it, damage, etc..

Animations
More advanced users may want to use the animation capabilities of Coldstone. The animation editor
lets you create frame by frame animation with an advanced movement control through a full featured
keyframe editor. You can use animations to represent characters and items as well as to add more
depth to your maps.
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The game folder

When you create a game, Coldstone automatically creates a folder (which you name) with a very
specific folder-hierarchy structure. It is extremely important that this basic structure remains
unchanged. If it is altered, Coldstone will not be able to find certain elements of your game, which
could result in serious errors. Here's the required structure and a description of what each folder
should contain:

Maps Contains all the map files.
Locations

• Defs Contains all the location files.
• Location pics Contains all the pictures used by the locations.

Events
• Defs Contains all the event files.
• Pics Contains all the pictures used by the events.

Items Contains all the item files.
NPCs Contains all the non-player character files. Those characters can

be placed anywhere in a map and can be either passive or
aggressive.

Players
• Classes Contains all the class files.
• Portraits Contains all the pictures from which the player can select his

portrait when creating a new character.
• Races Contains all the race files.
• Skill tables Contains all the skill table files.
• Spells Contains all the spell files.

Pictures Contains all the pictures used for maps, animations, and the
game interface. You can use folders of your own to subdivide
this folder’s contents into groups, such as “Outdoor tiles” or
“Hero animation frames”.

Music Contains all the music files that can be played during the game.
Sounds Contains all the sounds that can be played by the player, a

character or an event action.
Movies Contains all the Quicktime movies that you can display using an

“Dialog” action type (see the “The action types” section).

Note: For cross-platform compatibility, Coldstone does not support file aliases or shortcuts.
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Working Interface

The objective of Coldstone is to offer you maximum flexibility in your creation process. This is why
the editor puts at your disposal such a simple and effective interface, which will be shown here in five
parts: the menu bar, the tool window, the game and folder browser, the options panel, and the online
help system.

Menu bar
The menu bar has six menus: the standard system menu, the file menu, the edit menu, the project
menu, the tools menu and the help menu.

System menu

Displays the  “About Coldstone Game Engine…” splash
screen, with registration and version info.
Lets you register your copy of Coldstone. See the
“Registering  Coldstone” section.

File menu

Opens a sub-menu that lets you add an element to the
current game.
Opens the standard folder selection dialog. The file will be
opened with the appropriate editor or their creator
application if the format isn’t recognized by Coldstone.
Closes the front most window.
Saves the contents of the front most window.
Saves the contents of the front most window under a
different name.
Export the contents of the front most window as a template.
Creates a new game folder of the name specified by the user.
The current game is closed and the new one is opened for
editing.
Asks the user to select a game folder. The current game is
closed and the specified one is opened for editing.
Displays the preferences panel.
Closes all open windows and quits Coldstone.

Edit menu

Clears the contents of the current selection and copy it to
the clipboard.
Copies the contents of the current selection to the clipboard.
Replaces the contents of the current selection by the
content of the clipboard.
Clears the contents of the current selection.
Prompts the user to specify a new name for the current
selection or edited element.
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Project menu

Displays a dialog with the current game’s options.
See the “Plugin sub-menu” section below.
Shows or hides the Coldstone development tools.
Shows or hides the Coldstone game browser.
Compiles the current game and creates a stand-alone
application.
Optimizes and compiles the current game as a stand-alone
application for Macintosh and/or Windows systems with
additional security protection.
Starts the application (game) previously compiled.
Compiles the current game as a stand-alone application and
launch it.

Plugin sub-menu

Load a plugin data file into memory and switch the Coldstone
Editor to plugin development mode (see the  “Plugin
Development” section for more information).
Unload the previously loaded data file from memory and
switch the Coldstone Editor to standard development mode.
Displays the plugin load calls dialog. Only available when in
plugin development mode (see the “Plugin load calls” section
for more information).

Tools menu

Displays the random name generator window.
Displays the Tips of the day window
Displays a random dying sentence
Displays the map preview generator. Lets you re-generate
the preview pictures of all the maps found in the “Maps”
folder.

Help menu

Displays the standard system dialog about the balloon help.
Enables or disables the balloon help system (compatible with
Coldstone).
Shows the contextual help window.
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Tool Window

The tool window lets you add elements to your game and access other useful functions (which are
also available from the menu bar). The complete path to the current game folder is displayed at the
bottom, though it can be hidden by clicking on the disclosure triangle at the right end of the window.

Creates a new map.

Creates a new location.

Creates a new event.

Creates a new item.

Creates a new non-player character (NPC).

Creates a new race.

Creates a new class.

Creates a new skill table.

Creates a new spell.

Creates a new animation file.

Displays the current game/plugin options dialog.

Starts the previously compiled game application.

Displays the plugin load calls dialog. This button is displayed instead of the launch button
(the arrow above) when Coldstone is in plugin development mode. See the plugin section
of this manual for more information on Coldstone game plugins.

Opens the current game folder in the Finder.
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Game browser and folder browser

Since a Coldstone game in progress is no more than a folder that contains the various game elements
structured in a precise way, there is, of course, a navigation system built into the editor. Thus exists
the game browser and the folder browser, similar to a standard file browser of the system. It is
through this window that you will reach the elements of your game.

         

Click on an arrow to display or
hide the folder’s contents.

A double-click on a folder will automatically open another
folder browser with this folder as root (see the window’s title).

As mentioned above, if you double-click on a file supported by Coldstone, the file will open in its
editor. If Coldstone does not support the file, it is opened with the application it is associated with. If
no application supports this type of file, a warning window will inform you of this.

Note: Coldstone remembers the size and position of each individual file browser that you open.
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Preferences dialog

Most of the software out there lets you modify some options to fit your work style. Coldstone is no
exception.

Editor panel
Includes all the options related to the workspace interface and behavior.

Show tips:

Select this option if you want the Tips of the day
to be automatically displayed when you start
Coldstone.

Auto-Save file…
Select this option if you want the different
elements of your game to be automatically saved
in the correct sub folder. This option is highly
recommended.

Option-double-click…
Select this option if you want to be able to
launch another application to edit your picture
files by  double clicking on them (while pressing
the Option key). Select the application to launch
by clicking on the button below.

Don’t use double buffering: check this to
speed up map display in the map editor but you
will lose visual quality when editing your map.

Desired buffer depth: you can limit
Coldstone display buffers (used by the animation
editor and map editor) to a given color depth to
lower memory requirements of the Coldstone
application (not the resulting game).
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Templates panel

Includes the options related to the use of template files (models) in Coldstone. Each editor can have a
template file. When this is the case, it is this file which determines the default settings which will be
used at the creation of the corresponding element. If you create a whole series of items of the type
“armor”, you could create a new item file, select “armor” as its type and save it as a template file
(option “Save as Template” in the “File” menu). Then go to the templates panel in the options dialog
and associate the template file that you have just created with the items. Each new item will be
created with the “armor” type!

Associate a template file with an editor

- Select the editor that you want to associate
to a template file.

- Its name will appear in the bottom of the
window as will a popup menu with all the
template files of the same type (if you
selected the item editor, only the item
template files will appear in the list)

- Select the template file that you want to
establish as the new default for this editor.

- Click on the “OK” button to save your
modifications.
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Contextual help system

Coldstone offers a system of assistance directly integrated into the editor. Select the command
“Contextual Help” of the help menu to display the contextual help window:

The help text will be displayed here. When the
cursor is not in front of any element
connected to a help text, this default message
will be displayed.

This window will constantly display the help text connected to the button, field or list where the
mouse cursor is. It should be noted that you could also use the balloon help system integrated in the
system since it is fully supported by Coldstone.
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The statistic system

The player’s and the non-player characters’ strengths and weaknesses are represented by numeric
values. These values are not only used by the NPC editor but also in various other editors and event
action types. You will need to master the use of all the different statistic values to create a
challenging world for the player to conquer.

Important: The names of the statistics are for your reference only within Coldstone. You can call
them whatever you want in your interface (example: you could have the “Strength” attribute named
“Might”).

Primary statistics

Stamina points

Any character has stamina points3. These points are a measure of how healthy the character is. When
this value drops to zero, the character is dead.

Magic points

A character can cast spells4. These spells can be cast only if the character has enough magic points.
Every time the character casts a spell, his magic points decrease by the casting cost of the spell.

Secondary statistics

Strength

The physical strength of the character. This statistic value is used in battle to determine damage
bonus. Any points over 15 will be added to the final damage done by the character to its opponent,
though only when the character is using a weapon with a range less than or equal to 1.

Dexterity

The agility of the character in manipulating his weapon. This statistic value is used both offensively
and defensively in battle to determine if an attack will hit its target. Each time a character attacks,
the game rolls a number between 0 and the character’s dexterity and does the same thing for the
opponent. If the character rolls a higher number than his target, the attack is successful.

Vitality

This represents how good the character’s constitution is. This statistic value is used to calculate the
number of bonus stamina points that are added to the player’s maximum stamina when he gains a
level. Any points over 15 will be added to the stamina points bonus roll.

Wisdom

This represents how good the character is at casting spells and handling magic. This statistic value is
used to calculate the number of bonus magic points that are added to the player maximum magic
when he gains a level. Any points over 15 will be added to the magic points bonus roll.

Karma

Coldstone does not use this statistic by default. You can use it in events and the like to do whatever
you want.

                                                
3 Except passive NPCs, see the “Aggressive VS Passive NPCs” section for more details
4 See the “Spell Editor” section for more details on spells
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Luck

When a character strikes his opponent, the engine picks a random number between 0 and 100. If this
number is less than or equal to the attacker's luck, it will make a critical hit (the target character’s
armor is useless).

Speed

The movement speed of the character. It represents the number of pixels the character will move
each frame.

Perception

This represents how good the character’s vision is. This statistic value is used in battle to determine if
the character will hit its target when striking an opponent at a range greater than 1. Each time the
character attacks someone, using a range weapon, the game rolls a number between 0 and the
sum of the character’s dexterity and perception and does the same thing for the opponent. If the
character rolls a better number than its target, the attack is successful.

Resistances

Natural

The natural resistance of the character to normal attacks. This value is added to the armor statistic
when evaluating the amount of damage taken in battle. Use this to give a base armor value to your
character. Unlike the other resistance types, this value is NOT a percentage.

Fire

The character’s protection against fire damage. This value represents the percentage of fire damage
that will NOT affect the character.

Cold

The character’s protection against cold damage. This value represents the percentage of cold damage
that will NOT affect the character.

Chemical

The character’s protection against chemical damage. This value represents the percentage of
chemical damage that will NOT affect the character.

Electrical

The character’s protection against electrical damage. This value represents the percentage of
electrical damage that will NOT affect the character.

Note: Again, the resistance names are for your reference only. You can name them whatever you
want in your game. Pillars of Garendall, for example, uses the fire resistance attribute as “Mind
protection” and the chemical resistance as “Undead protection”. Also, resistances less than zero lead
to weakness (increased damage) and resistances above 100 lead to healing from an attack of that
sort.
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Fighting attributes

Damage minimum – maximum

Each time a character successfully strikes his opponent, the engine will pick a random number
between the damage minimum number and the damage maximum number. This number will then be
removed from the current number of stamina points the opponent has. If its stamina points drop to 0,
the opponent will die.

Damage type

The type of damage dealt by the character when striking his opponent in battle. The opponent,
depending on the type of the attack may absorb a portion of the damage. Any “natural” attack will
use the combined value of the armor and natural resistance to evaluate the final damage taken by the
target. The other four types (fire, cold, chemical and electrical) will use the associated resistance (see
“Resistances” above) and ignore the armor value.

Damage of type “magic” is considered as pure damage that the target can’t absorb at all. No
resistance or armor is evaluated in this case.

When you create a new non-player character, you can select its basic damage type from the “Damage
type” popup menu. However, if you select a weapon in its inventory that the character will have
equipped, the weapon damage type will replace its damage type unless its damage type is set to
“Natural”.

Armor

The armor is a measure of how well protected the character is against natural attacks. Each time a
character attacks, the game rolls a number for the attacker and the target (see “Dexterity” above).
The attacker number must be higher than the target number for a successful attack. The closer  the
target number is to the attacker number, the most effective will be the armor. Example: for a target
number of 10 and an attacker number of 20, the armor effectiveness will be 50% while the numbers
19 and 20 will result in an armor effectiveness of almost 100%. The final armor value is subtracted
from the damage value.  Note: The armor effectiveness minimum is 40%, no matter what.

Experience attributes

Experience points

This attribute only applies to the player. Every time the player kills a character, he gains experience
points. You could also manually give experience to the player with the “Attribute Wizard” action (see
the “Event editor” section) to reward him for completing a particular quest for example. These
experience points are used to gain levels during the game.

Level

This is a measure of how experienced your character is. When the character has a certain number of
experience points5, he will gain a new level. First, it will display the “Level up” dialog (see the “Layout
types” section) and then give a bonus to the maximum stamina points. If the player is a magic user

                                                
5 See the “Skill Table editor” section for information on how to modify the required number of experience points for each level.



Coldstone™ User Manual by Beenox inc. ©1999-2001 Beenox inc. All rights reserved. 22

(i.e., if he has at least one spell permitted by his class), he will receive a bonus to his maximum magic
points as well. This bonus will be a randomly generated number between 1 and 5. Any vitality points
over 15 will be added to the stamina bonus. The same thing applies to wisdom for the magic bonus.
You can also manually give statistics bonuses or other special abilities to the player when he gains
specific levels by using event links in the player’s skill table6.

Note: You are not forced to use the experience points/level scheme in your game. If you set all
opponent experience points to 0, they will never give you anything. It could be useful if you would like
to create a game which only rewards experience points to the player for quest completion.

                                                
6 Again, see the “Skill table editor” section for more information.
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The editors

Each elements of the game (maps, items, characters, etc.) has a specific editor window. Each editor is
explained here in detail.

Map Editor

A map is made of a table of tiles (with width and height determined by the user) that represent the
ground, and layers. Layers can contain various graphical objects that are rendered over the ground.
The map editor lets the user edit a map in six modes: drawing the ground, drawing in layers,
management of the tiles to which the player has access, definition of the various events which can
occur there and placing the items and NPCs.

How to create a map

Select the command “New -> Map” from the “File” menu or click on the corresponding button in the
tool window. The map creation dialog will appear:

A Coldstone map is divided in two separate grids: movement grid and the ground grid. The movement
grid separates the map into tiles that the player can step on. It’s also using this grid that you will
place events and determine access values. The ground grid is only used to draw the background of
your map (when you are in “Ground” mode in the map editor – see below). It is provided as a separate
grid so that you can create ground tiles of a higher resolution without influencing the movement of
the player and NPCs.

The ground is divided by the red grid
(using 96x96 pixel images) but the
player will move according to the
white grid (set to 32x32 pixels).
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The map editor opens displaying a blank map of the specified dimensions.

Map editor interface

Tip: keep the numbers in the “Stats” box low to reduce the memory requirements of your game. This
will also greatly affect the loading time of the map.

Lets you perform
various
operations on
the current map.

Zooms in and
zooms out the
map view.

Changes the map
editing mode.
See editing
modes section.

List of all the
layers in this
map. Layers at
the top of the
list are drawn
behind those at
the bottom. Use
the "+" and "-"
keys to move a
layer up or down.

The map title and
current edition mode.

Displays the
current picture
used for drawing
operations.

This area displays the
current map. Use the
scrollbars to navigate.

Displays information related to the
position of the cursor; i.e., the
coordinates of the movement tile and
ground tile beneath the cursor and the
pixel coordinates of the cursor relative
to the upper left corner of the map.

Displays information related to
the tile beneath the cursor: the
complete access path of the
picture file, the name of the NPC
or item on this tile (if any) and
the name of the event
connected to this tile (if any).

Displays the number
of different textures
currently used in the
map, number of
objects in the
current layer and in
the entire map.

Toggle between
the layer list and
a list of all the
local events
saved in this
map.

Lets you toggle
the ground
visibility.
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Tile set viewer

When you edit a map in the map editor, the tile set viewer will automatically open, displaying the
contents of your “Pictures” folder. The same interface is often used for picture selection in other
editors (like the range animation picture in the item editor).

Refresh the popup menu if subfolders are added to or removed from the “Pictures”
folder while you are editing a map. This button is disabled in “Items” and
“Characters” modes since sub folders are not supported in those modes.
Switch between graphical display (shown in the above screenshot) and text display.
In the latter mode, the names of all the files in the selected folder appear in a
standard listbox. Especially useful in “Characters” or “Items” mode, since the same
picture or animation may be used by many objects.

  
Expand or reduce the display size of the pictures.

The name and
dimensions of the
selected picture.

Click on any picture to
establish it as the
picture used for
drawing operations.

All the sub folders in
the “Pictures” folder
will appear in this
popup menu as tileset
libraries. Select the
library that you want
to be displayed. The
default is the root

Navigate through the
current tileset library.
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Ground Mode

Activate the
pencil tool
which operates
on a single tile.

Activate the paint
bucket tool which
operates on all the
adjacent tiles of
the same attribute.

Activate the eraser
tool. Clear the
clicked tile (this tile
will not be drawn in
your game).

Activate capture
tool. Set the
current tile to
the clicked tile.

To draw the background of your map, select “Ground” mode from the left side of the Map Editor
(ground drawing, see the map editor picture above). The current mode will be displayed in the
window’s title bar. From the tile set viewer, select the tile with which you want to draw. This image will
become the new current tile (displayed in the top left corner of the editor). Click on the pencil and
click on one or more tiles in the map in order to change the image to the current tile. Note: Be sure to
check the “Ground Tools” section that describe how to build tools that will help you create beautiful
landscapes in seconds.

Layers Mode

Activate the
pencil tool which
lets you add
objects in the
selected layer.

Activate the move
tool which lets
you move around
the objects of
the selected
layer.

Activate the
eraser tool.
Remove the
clicked object
from the
selected layer.

Activate capture
tool. Set the
current object to
the clicked object.

Layers are probably one of the greatest features of Coldstone. Using layers, you can put pictures of
any size over the ground of your map to add realism and create breath-taking environments in a snap.
One layer can contains a series of pictures or animations of any size (not limited to 32x32 pixels or
something silly like this) placed at any pixel coordinates. When the map is displayed, your game will
first draw all the ground and then will draw the content of all layers, one after another.

Ground Layer 1 Layer 2 Layer 3

When the map is displayed, the layers are “flattened” to create a beautiful game scene
(white is considered as transparent).

Ground

Layer 1

Layer 2

Layer 3
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When you have at least one layer in your map, you will notice that a special layer, the
“<<PLAYER>>” layer, is automatically created. This layer can’t contain objects and cannot be
deleted, but can be moved up and down within the layer list. This layer is where all the characters
(including the player himself) will be drawn. This special layer should be placed between what you want
to appear under the player and what you want to appear over the player. The layer immediately below
the player layer in the list will be dynamically Y-sorted (see illustration below) with the game
characters while all the subsequent layers (down in the list) will always appear over them.

Dynamic Y sorting
Coldstone automatically depth-sorts characters with the layer following the <<PLAYER>> layer.

It compares the bottom edge of each of the characters with the other objects (as well as the other characters) to
dertermine which one should appear in front of the other.

Manipulating layers

Use the buttons under the layer list in the map editor to add, duplicate, merge, delete or move layers
within the list.

Create a new layer in which you will be able to add objects. It will first ask you for the name of
the layer to create. You can enter any name you want, purely for your own reference. The new
layer will appear at the bottom of the layer list.
Make a copy of the selected layer. All the objects of the source layer will be added to the new
layer.
Merge the selected layer with the layer under it in the list (only enabled if there is one selection
in the layer list and if there is at least one layer under it). All the objects of the two layers will
now appear in the same layer. The layer under the source layer is deleted.
Delete the selected layer permanently.

Move the selected layer up in the layer list (use this to move the <<PLAYER>> layer as well).
You can also use the “-“ key to move a layer up in the list.
Move the selected layer down in the layer list (use this to move the <<PLAYER>> layer as
well). You can also use the “+” key to move a layer down in the list.

Adding objects to a layer

To add an object in a layer, you must first select a layer in the list (don’t forget that you can’t draw in
the <<PLAYER>> layer!). Select an object in the tile set viewer and select the pencil tool. Move your
cursor over the map and click where you want the object to appear.

Woman
appears
behind the
tree
(character’s
bottom edge
is above the
tree’s bottom
edge).

Woman appears in
front of the tree
(character’s
bottom edge is
below the tree’s
bottom edge).
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Characters Mode

Activate the pencil
tool to add a
character to the
map.

Activate the move
tool to move the
selected character
around the map.

Activate the
rotate tool to let
you change the
initial facing
direction of the
character.

Activate the
eraser tool. Clear
the clicked tile’s
NPC if any.

The “Characters” mode lets you add characters directly in the map editor and set their initial facing
direction. To add a character on the map, first select the characters mode and then select the
character you want to add from the list appearing in the tile set viewer7. Just click on the tile where
you want to add your character. You can hold the mouse button down and move your cursor around
the character to set its facing direction8.

Unlike layer objects, characters can’t be placed at any screen coordinates. They must be placed on a
tile and you can’t have more than one character on a given tile (if you try to do so, the editor will
display an error message). When you use the different character tools (see above), remember to click
on the tile on which the character is standing to select it, not the character itself.

Items Mode

The “Items” mode works exactly the same way as the NPC mode except that it lets you add items
from your “Items” folder.

Access Mode

Activate the pencil
tool which operates
on a single tile.

Activate the paint bucket tool
which operates on all the adjacent
tiles of the same attribute.

Activate the eraser tool.
Clear the clicked tile’s
access value.

In the majority of maps you will design, there will be places that the player will not be able to go. If
you have a lake, for example, it would be good to stop the player from walking on the water. Thus you
will have to define the access of each one of your tiles.

Click on the access button to switch to access mode. When a tile is not accessible, a red translucent
pattern will appear automatically over the image of the tile9 like this:

Clear for access Blocked

All tiles are accessible at creation. To change the access of a tile, choose the pencil and then click on
the tile whose access you wish to modify. An accessible tile will become inaccessible and an
inaccessible tile will become accessible.

                                                
7 This list is the content of your “NPCs:Defs” folder; if you haven't created any NPCs, the list will be empty. See the “Non-Player
Character Editor” section for more information.
8 This is only important if this character has a directional animation associated with it – see the “Animation Editor” section.
9 Of course, this pattern will not appear when the player walks around the map during the game.
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Events Mode

Activate the pencil tool
which lets you link a tile to
an event from the map’s
local event list.

Activate the global pencil
tool which lets you link a
tile to an event from the
game “Events:Defs:” folder.

Activate the eraser tool.
Clear the event linked to
the clicked tile (if any).

A map without events is like a world without life. You will have to add certain events to your map even
if they're only for teleporting the player into a city or to make him discover a secret passage for
instance. To arrive at such a result, you will have to place events. Each tile can have one event which
will be launched each time the player enters the tile. When a tile has an event assigned, an event icon

(  ) will appear on this tile (in event mode only).

To assign an event, switch to event mode, then select the pencil and click on the tile to which you
wish to add or modify an event. A drop-down menu will appear with a list of events present in the
current game. Select the event in the list to assign it to this tile.

To erase the event link on any tile,  simply use the eraser tool.

Local events

You can define events that will be saved within the map file, not in the standard “Events:Defs:”
folder. These events are called local events. Create local events when their actions are only related
to their parent map like an event that would teleport the player to another map such as a cave
entrance. Click on the “Events” tab in the map editor to view the local event list. The buttons under
the list will let you control the local events:

Create a new local event in the current map

Delete the selected local event

Edit the content of the selected local event

Rename the selected local event
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Additional tools

The popup menu under the picture preview in the map editor offers additional tools to the Coldstone
user to perform various actions on the current map.

Change map dimensions Lets you change the initial dimensions of the map, the size of the
movement grid and size of the ground grid.

Map grid Lets you display a grid over the map display. You can specify the grid
spacing (in movement tiles) and the grid color.

Activate stamp snap Lets you activate/deactivate the snap-to-grid option. Any stamp placed
on the map will automatically “snap” to the upper corner of the nearest
grid tile (you can specify the grid with the “Map grid” tool – see above).

Optimize ground This will erase any ground tile that is completely covered by other
stamps.

Create map preview
picture

This will export the current map in the given dimensions. The resulting file
will be saved in the “Locations:Location Pics:” folder with the same name
as the map. Useful for quickly creating map previews used by the “Map
overview display” action in events.

Reset access values Reset all movement tiles access values to true (i.e. clear for passage).
Export as picture Export the current map as a standard macintosh PICT file.
Export as JPEG Export the current map as a JPEG file.
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Ground Tools

With Coldstone, you can create your very own ground tools. A ground tool is a standard
Coldstone animation file10 that contains a predefined number of frames representing all the
pictures needed to quickly generate a transition between two types of ground. You could build
yourself a ground tool that will let you trace a river over a grass terrain in seconds without having to
manually place all the corresponding transition tiles  between the grass and the river.

A ground tool has 14 frames. The order of each frame can’t be changed. Here’s an example of a
ground tool that would allow you to draw water over grass:

Frame 1
The base tile that is to be applied over the current ground tile

Frame 2
The original tile over which the base tile (frame 1) is to be applied.

Frame 3
North transition between the base tile and the original tile.

Frame 4
North East transition between the base tile and the original tile.

Frame 5
East transition between the base tile and the original tile.

Frame 6
South East transition between the base tile and the original tile.

Frame 7
South transition between the base tile and the original tile.

Frame 8
South West transition between the base tile and the original tile.

Frame 9
West transition between the base tile and the original tile.

Frame 10
North West transition between the base tile and the original tile.

Frame 11
North East corner transition between the base tile and the
original tile
Frame 12
South East corner transition between the base tile and the
original tile
Frame 13
South West corner transition between the base tile and the
original tile
Frame 14
North West corner transition between the base tile and the
original tile

                                                
10 See the “Animation Editor” section for more information on how to create an animation

1 2

3 4

5

678

9

1

14 11

1213

To use a ground
tool, just save
the animation
file within the
“Pictures” folder
of your game
project. In the
map editor,
switch to
“Ground” mode
and select your
animation in the
picture browser.
Click in a region
covered with the
original tile
specified (frame
2).
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Location editor

Locations are very significant. It’s with locations that you send the player from one map to another or
you display an image in which the player will be able to click. The player is always in a location. For
example, the player is never considered to be in a map but in a location of the type “Map”. There are
several types of locations, each one having a particular use and set of parameters.

How to create a location

Select the command “New -> Location” from the “File” menu or click on the corresponding button in
the tool window. A blank location editor will appear.

Location editor interface

Current location type. Click to change
the location type.

The general initialization event is called
just before the location is displayed.
This event is external which means
that the event is stored in a separate
event file.

The local initialisation event is called
just before the location is displayed,
after the general event. This event is
local which means that the event is
stored in the location file itself. When a
local event contains at least one
action, the edit button will have a bold
caption. Click the “X” button to delete
all actions of the local event.

Add, edit and delete location links. This is
available only for main locations. To add a
link, select a location from the list and click
the “+” button. The coordinates window will
appear automatically. The “-“ button delete
the selected link from the list. Double-click
any link to edit its coordinates.

Display a preview of the picture linked to this
location (if any). The picture file must be in the
“Location pics” folder and must have the same name
as the current location.

Check this option if you want this
location to use the standard interface
layout for locations of this type. This
option is available only for main location
and map location. If this option is not
selected, only the location picture will
be displayed on the screen.



Coldstone™ User Manual by Beenox inc. ©1999-2001 Beenox inc. All rights reserved. 33

What are location links?

Main locations can (optionally) have location links — zones where the player will be able to click in
order to display or activate this location (i.e.: a map location will display its map file). Each link has
coordinates, which defines the click zone for the user. Here's an example to enlighten you:

The player finds himself in a tavern. You give him the option of going to visit a table or going to the
second floor. To do so, you create a location named “Tavern”, another named “Table of tavern” and
finally, “Second floor of the tavern” (see graphics below). So that the table and the second floor are
accessible by the tavern, you must open the “Tavern” location, select the “Table of Tavern” from the
popup menu and press the “+” button to add it to the list and assign it coordinates. Repeat the same
thing for the second floor. The coordinates of each one determines where the player must click to
activate (open) them.

Location :
“Tavern”
Type : Main
(picture only)

(104,8

(360,14(48,17

(200,15

Location : “Table of tavern”
Type : Main (picture only)
Parent location : “Tavern”
Coordinates:
Left : 48, Top : 170, Right :200,
Bottom : 156

Location : “Second floor of the
tavern”
Type : Main (picture only)
Parent location : “Tavern”
Coordinates:
Left : 104, Top : 85, Right :360,

When the
player clicks…
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In the example above, the parent location is used to link locations of the type “Main” together. Such a
relationship can exist with all the other types of locations. It is possible, for example, to bind a place
of the type “Event link” (link with an event) to the location “Tavern”. It is then an event that will be
launched, and not a picture.

The coordinates window

This window is closely related to the link between a main location and its sub locations (links)
because it allows the user to visualize and determine easily the coordinates of the links’ hotspot.

When you create or edit a location link (see “Location editor interface”), the coordinates window
appears displaying the picture of the main location:

Click in the image and drag the cursor in order to increase the zone of click as needed. When you are
satisfied, press on the button “Apply” which saves your modifications.

Thus, to define the coordinates of the location “Table of tavern”11, you just have to choose it in the
popup menu (from the “Tavern” location editor), click on the “+” button and there it is.

                                                
11 See the example in the section “What are location links?”
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Location types

Coldstone lets you define several types of locations. Each location has particular parameters. The
parameters specific to the types of location are found under the “Additional” panel of the location
editor. Here is a short description of each type:

Main location :   Displays a picture in which the player can click to
open other linked locations.
Map : Display a map on the screen in which the player is able to
move.
Event link :  Launch the event of the same name.
Shop :  Opens a shop window. The player can buy items from a
predefined list or sell items from his inventory.

Main location

When a location of this type is activated, the image of the same name is displayed. The image must
be in the “Location pics” folder in your game folder and must have exactly the same name as the
location to which it refers. If this location has linked locations, they will be activated when the player
clicks in the area defined by their coordinates12. The parameters particular to this type of location are
the following:

Ambient sounds :

Ambient sounds are sounds that are played
while the player is in this place, according to
a certain probability. The more the
probability is raised, the more often the
sound will play. To define an ambient sound,
you only have to select it in the list (you
must be sure that it is in the sound folder of
your game folder). Select “None” in the list
to remove it. You are limited to a maximum
of 3 ambient sounds per location.

Important: ambient sounds only check to
play at regular intervals; setting a sound’s
probability to 100% will not cause it to loop.

Keydown events :

Keydown events are events that will be
carried out automatically when the player
presses on a particular key while in this
location. Click on the button “+” to add an
event and click on the button “–” to erase
the selected event. Check the box “Uses
global keydown events” if you want the
global keydown events to be taken into
account13.

                                                
12 See the section “What are location links?”
13 See the section “Game options” for more details on global keydown events
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Shop

Locations of the type “Shop” display a window with an image of your choice as well as a list of items.
The player can buy the items of his choice and can also sell items from his inventory14. The
“additional” panel displays a list of items present in the game and a price multiplier. The price
multipliers influence the price at which the merchant will sell the items. When the price multiplier is
“Normal” (default value), the merchant will sell the items at the price which you have specified. The
other indices will decrease or increase the prices. When the player sells an item, the merchant always
buys the item half the price at which he would sell it.

Simply check the boxes beside the items that you want the shop to sell. A shop can also display an
image in its “Picture” zone (see the “Shop” layout). To do so, the image must be in the folder
“Location pics” in your game folder and must have exactly the same name as the location to which it
refers. It should be noted that you can directly edit an item by double-clicking on its name in the list.

The “Shop” locations also have two local events (saved in the location file). The first event is
executed when the player tries to buy an item that costs too much for him and the other is executed
when the player leaves the shop by clicking on the “Leave” button. Click on the “Edit” button to edit
the events and on the “X” buttons to delete them.

                                                
14 The player can’t sell an item that has a price equal to zero (so be sure to set the item price of any special quest item to zero so
that the player can’t accidentally lose it).
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Event link

When a location of this type is activated, the linked event is automatically launched. The event must
be in the folder “Defs” in the events folder and must have exactly the same name as the location to
which it refers. A location of this type has no specific parameters. Note: a button “Edit event” is
visible and makes it possible to automatically open the linked event. If no linked event is found, a new
event is created with the appropriate name.  You could also simply add the actions you want to be
executed in the local link of this location (see “Location editor interface”).

Map

A location of this type displays a map on the screen in which the player is able to move. The map
must be in the “Maps” folder and must have exactly the same name as the location. The specific
parameters of a “Map” location include all of those found in “Main” locations, with the addition of
auto-switch locations. Auto-switch locations are locations that will be opened automatically when the
player moves to the north, south, east or west border of the map. If these locations are of type
“Map”, the player position will be automatically adjusted to fit in the next map. For example, if the
player reach the northern border at coordinates (12,1) and the auto-switch location for the north is
set to a 20x20 tiles map, this map will open and the player will appear at coordinates (12,20).
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Event editor

How to create an event

Select the command “New -> Event” from the “File” menu or click on the corresponding button in the
tool window. A blank event editor will appear.

What is an event?

An event lets you create the story and quests for your game. It’s with events that you will direct the
player in one direction or another. It’s also with events that you will be able to control the player’s
statistics and inventory. In short, events give you total control over your game.

Event editor interface

An event is made of a series of actions of different types (image display, music control, etc.). The
event actions are divided in two categories: the main sequence actions and the linked actions.
The main actions are those which are executed when the event is launched. Some types of actions
can call others (like the answer choices in a dialog for example). Called actions that will only be
executed in certain cases should be placed in the linked events category.

Click and drag to
one of the lists
to create an
action of this
type.

The event lib displays a list of all
the types of actions in
Coldstone. The description of
the selected type will appear at
the bottom of the window.

The event editor window is divided into two lists: the main
action list and the linked action list. The actions on the left
will be executed sequentially from the top. Any action that is
launched by another must be placed in the right part. Use
the “+” and “-” keys of your keyboard to move the actions
up and down in the list or the arrow buttons at the top of
the lists.
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Add an action to an event

To add an action to an event, you must first open that event. You will have two new windows on your
screen: the event library window and the event editor itself. Select the type of action you want to
add from the event library window. Drag the selected type to one of the two lists in the event editor.
The following dialog appears:

<

Now you must give a name to the new action. This name will be displayed in the action list15. It will
also be used to identify the links between the actions. You can always rename an action by selecting
it and choosing the “Rename” command from the “Edit” menu.

The action types

Ask Entry
Display a dialog box with text, a picture and an entry field in which the player must enter a value.

Attribute Wizard
Change the value of one of the player's attributes. This action’s parameters are used the same way
as those of the “Change Globals” action type. Please refer to it for more information on this topic.

Note: If you add a value to the experience points of the player, and the new total exceeds the
number required for the next level, the level up dialog will immediately show up and all events linked
to the new level will also be executed before the original event can proceed to the next action.

Call Event
Execute another event. Select the event you want to be executed from the list (displays the content
of your “Events:Defs” folder). The execution of the current event is paused until the called event is
finished.

                                                
15 It is strongly advised to use a name that makes it possible to easily determine the purpose of the action. You will then be able to
navigate more easily in an event with many actions.

The name of the action to create or
rename.

The type of action to create (or the
type of action being renamed).
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Change Globals
Change the value of one of the global event variables. The “Random” operator sets the global variable
value to a random number between 0 and the number specified in the value field.

Change Map Cell
Change the attributes of a given map cell (tile picture, access and linked event) of the current opened
map. If the current location (when this action is executed) is not a map, this action does nothing.
Important: when you want to change the picture, you must enter the coordinates of the ground tile,
not the movement tile, which are not necessarily the same (see the map attributes and mouse
coordinates in the map editor).

Enter the coordinates of the cell you want
to modify.

Select the new ground picture for this cell.
You must check the “Change cell picture”
button for this to be effective.

Select the new access value for this cell.
You must check the “Change cell access”
button for this to be effective.

Select the new event for this cell. You must
check the “Change cell event” button for
this to be effective.

Select the global to modify from the list
(see the “Global event variables” section).

Select type of operation to do on the
selected global.

Enter the operation value. In addition to raw
numbers, many global variables and
statistics can also be used as the
"operation value" through use of the popup
menu next to the "operation value" text
box. Example: if you would like to increment
a global variable of 2 units, select this
global in the list and the “Add” operator
with an operation value of 2.
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Conditional
Execute an action only if the condition that you specified is true. Example: if you would like to know if
the player has at least 10 gold coins, select the “Gold” value in the list with the “is greater or equal”
operator and enter 10 in the value field.

Dialog
Display a dialog box with text, a picture and answer choices (all are optional). See the “Tag Values”
section for more information on how to add variable text.

End Event
End the execution of the current event, regardless of any remaining event actions. This action type
has no parameters.

Engine Call
Execute an internal engine function (start a new game, show the statistic sheet, etc.).

Enter the text to be displayed for each of
the answer choice (maximum of 3). Leave
these fields empty if you don’t want answer
choices to be displayed. Select the action  to
execute when the player will click this link. If
no action is linked to an answer choice, the
dialog will be simply closed.

Enter the text to be displayed. You can leave
this field empty if you only want to display a
picture or play a movie.

Select the picture to be displayed from the
list (optional). If you would like to play a
movie instead, click on the “Movie” button
and select one from the list.

Let you quickly insert a tag value in the field.

Select the object to test from the list.

Select the operator of the condition i.e.
what type of comparison to do on the
selected object.

Enter the comparison value.

Select what action to do if all the conditions
or any condition in the list (see the radio
buttons above the list) is true and what if
it’s false.

Click the “+” button to add the current
condition to the condition list. Click the “-“
button to delete the selected condition
from the list.
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Fade Effect
Create a fade to black or fade from black effect. Use the slider to set the screen fading speed. Good
for transitions between locations.
Gold Wizard
Change the amount of gold that the player is carrying (add, subtract, etc.). . This action’s parameters
are used the same way as those of the “Change Globals” action type. Please refer to it for more
information on this topic.

Item Wizard
Lets you control the player's equipment (add, drop or use equipment).

Launch Item
Launch specific or random items on the current map at the given coordinates. You can also use this
action type to launch a specific amount of gold. All the edit fields of this dialog are compatible with
tag values (see the “Tag values” section below). You can choose to launch an item on the current
map at specific coordinates or you can launch it at the actual coordinates. The default value of
the actual coordinates is equal to the player’s position on the current map. However, if the action is
called within an event linked to an NPC (linked to its death for example – see the NPC editor section),
these coordinates will be equal to the NPC’s position on the map. The same principle is true for an
event linked to an item that calls a launch item action (like a chest). If you launch gold pieces (if you
specify a number greater than 0), it will use the gold picture specified in the game options “Misc”
panel.

Check from the list to the right all the items
you want to have a chance to be launched. If
the game needs to launch a random item (see
below), it will pick only ONE item from this
list and launch it.

The game will pick a random number between
0 and 100. If the resulting number is below or
equal to the number specified there, the
game will attempt to launch one random item.

Select all items that you want to be
“launched” at the given coordinates from the
list to the left. Be sure that these items have
a map picture linked to them.

Select which operation to do with the selected
item(s). The “Add inventory” operator will add all
items to the player inventory without checking
anything. The “Add unique” operator will add each
selected item, but only if the player doesn’t already
have it in inventory. The “Drop” operator will
remove one item of each selected item type from
the player inventory. Finally, the “Use/Equip”
operator will attempt to use or equip the selected
items (depending on the item type) only if the
player already has these items in
inventory.

Select all of the items that you want to be affected
by this action (Add, Add unique or Drop).
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Launch URL
Launch the specified URL in the default web browser.

Map Overview Display
This will display the map overview window (see the “Map Overview” layout in the game options) with
the picture with the same name as the current map, found in the “Locations:Locations Pics:” folder.
You must choose a picture to represent the current player position on the map. You can also choose
if you want to see the aggressive NPC positions (any NPC that will attack the player on sight) as red
dots and/or passive NPC positions as blue dots. There is also the option to activate a “fog of war”
which will hide any unexplored region to the player. Note: If enabled, NPC positions will not appear in
areas of the map covered by the fog of war.

Map Position
Change the current map position of the player. Use this before opening a location of type map to set
the coordinates of the player (even if the player is not in a map when you call this action, its
coordinates will remain for the next map). You could add an action of this type in the local
initialization event16 of a map location for example (if the player always starts at the same
coordinates in this map).

Menubar State
Show or hide the menubar. The toggle option will reverse the current visibility state of the menubar.

NPC Control
Add or remove one or more NPCs from the current map. Note: The “Kill” action is the same as the
“Delete” action except that it will remove the NPC(s) with a dissolve effect, as if killed in combat.

                                                
16 See the “Location editor interface” for more information on initialization events.

Select if you want to add a new NPC,
remove one or delete all NPCs of the
current map. If you choose to delete a NPC,
it will only delete one NPC of the selected
kind (the first added).

The kind of NPC to add or remove.

Where on the map to place the NPC.

The coordinates of the new NPC (if the
“Custom” placement mode is selected).
Note: these fields support tag values.

List of all the NPC operations that will be
executed by this action (from top to
bottom). Use the “+” button to add an
operation and the “-” button to delete the
selected one.
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Play Music
Play music from your game's “Music” folder.

Play Sound
Play a sound from your “Sounds” folder. There are two modes of play. The first mode will start the
sound and proceed to the next action in the event even if the sound is still playing. The second mode
will wait until the sound has finished playing before proceeding to the next action.

Player Map Icon
Change the image representation of the player when walking on a map. Click on the “...” button and
select the new picture from the Tile Set browser that opens.

Player Portrait
Change the image portrait of the player. Select the new picture from the list (displays the content of
your “Player:Portraits” folder).

Random Action
Execute an action on a random basis.

The engine will pick a random number
between 1 and 100. If the random number
is equal or less than this value, the random
result will be considered “true”.

The actions to execute if the random result
is true (if true do…) or if it’s false (else
do…).

Select the music to play from the list
(displays the content of your “Music”
folder).

Check this option if you want the engine to
automatically restart the old music after
the event is finished.

Select the sound to play from the list
(displays the content of your “Sounds”
folder).

Click on this button to listen to the
selected sound. You can also double-click
on any sound in the list to listen to it.

Select if you want to play the sound
without pausing the event execution or if
you want to pause the event until the
sound has finished playing.
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Refresh Screen
Redraw the actual screen. This action type has no parameters. You should use this event when the
engine doesn’t automatically refresh the screen for you like when you dynamically add pictures in a
main location (see the “Stamp Control” action type).

Restore Location
Restore the last saved location parameters and remove it from the location stack. The location stack
can only be controlled with “Save/Restore Location” location type. This action type has no
parameters.

Save Location
Add the current location parameters on the location stack (location name, player coordinates and the
current music). The location stack can only be controlled with “Save/Restore Location” location
type. This action type has no parameters.

Set Music Volume
Enter a value between 0 and 100 to set the game music volume. Set to 0 to turn the music off and
to 100 for the maximum output possible. Note: you can use tag values to specify the music volume.

Spell Selection
Display the spell selection dialog and allow the player to select a predefined number of spells of each
level.

Select a spell level for the player to choose
new spells from.

The maximum number of new spells that
the player will be able to select for this spell
level.

Add the specified level to the list or remove
the current selection.

The list of all the spell selections available
to this player. The order has no importance.

map location

main location

The parameters of the last saved location (with a “Save
Location” action) are restored (location, coordinates,
music) and the location is removed from the location
stack.

Last saved location

main location

map location
The last saved location will be the first to be restored when
a “Restore Location” action will be executed.

Current location
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Spell Wizard
Add or remove a spell from the player's spell book.

Stamp Control
Add/modify/remove stamps (pictures rendered over the background with transparency) in the
current main location or the current map. When added to a map, the stamps are facing north by
default. (This is meaningful only for if the stamp uses a directional animation.)

Note: Main locations don’t support animated stamps.

Task list control
Let’s you modify the content of the player’s task list (see the “Task List” layout).  Note that the task
list is displayed using an engine call with the “Open player’s task list” option selected.

Teleport
Teleport the player to the location of your choice. Select the location you want to be opened from
the list (displays the content of your “Locations:Defs” folder). If used to teleport to a map location,
this action should probably be preceded by a “Map Position” action to set the initial player position on
the map.

User Control
Enable or disable mouse and keyboard support for controlling the main character in maps. When the
game starts, mouse support is enabled by default and keyboard support is disabled by default. If
keyboard control is enabled, the character can be moved using the arrow keys or the numeric key
pad.

Wait
Wait some time before proceeding to the next action. The engine is completely frozen during a “wait”
except that sounds and music will keep playing.  The time unit is milliseconds which means that 1000
units are equal to 1 second.

Select which operation to do with the
selected spell(s). The “Add…” operator will
add all selected spells to the player spell
book. The “Remove” operator will remove
the selected spell(s) from the player’s spell
book.

Select all the spells that you want to be
affected by the selected operator (Add and
Remove).
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Tag values

Tag values are precise expressions that can be inserted in a dialog text in the editor. At the time the
text is displayed during the game, these indices are replaced by the current value of what it
represents. For example, the expression “&&Name” will be replaced by the name of the player. All
the tag values are case-sensitive. Here’s the list of all the expressions supported at this time
by Coldstone:

&&Name The name of the player.

&&Job The class of the player.

&&Race The race of the player.

&&Gold The amount of gold that the player is carrying.

&&Level The actual level of the player.

&&Experience The number of experience points that the player has gained.

&&NextLevelNeeded The number of experience points needed to gain another level.

&&StaminaPoints The number of stamina points that the player has.

&&MaxStaminaPoints The maximum number of stamina points that the player can have.

&&MagicPoints The number of magic points that the player has.

&&MaxMagicPoints The maximum number of magic points that the player can have.

&&MinDamage The minimum number of damage that the player can inflict to his
target.

&&MaxDamage The maximum number of damage that the player can inflict to his
target.

&&SpecialDamage The bonus damage that is added to the normal damage.

&&Armor The protection of the player (given by the equipment he is wearing)
against natural damage.

&&Strength The strength of the player.

&&Dexterity The dexterity of the player.

&&Vitality The vitality of the player.

&&Wisdom The wisdom of the player.

&&Karma The karma of the player.

&&Luck The luck of the player.

&&Speed The speed of the player.

&&Perception The perception of the player.

&&NaturalPro The base protection of the player against natural damage.

&&FirePro The percentage protection of the player against fire damage.

&&ColdPro The percentage protection of the player against cold damage.

&&ChemicalPro The percentage protection of the player against chemical damage.

&&ElectricalPro The percentage protection of the player against electrical damage.

&&PlayerX - &&PlayerY The current map coordinates of the player.

&&ActualX - &&ActualY The map coordinates of the active NPC (ex.: if you use these in an
event linked to a NPC death, these will represent its map coordinates).

&&CameraX-&&CameraY The absolute coordinates of the top left corner of the screen in the
current map.

&&LocationName The current location name.

&&LocationType The current location type.

&&CounterNPCs The total number of NPCs on the current map.
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&&CounterPassiveNPCs The total number of passive NPCs on the current map (i.e. villagers).

&&CounterAggressiveNPCs The total number of aggressive NPCs on the current map (i.e. those
which will attack the player on sight).

&&CounterHostileNPCs The total number of NPCs on the current map currently attacking the
player.

&&(globals) The tag value symbol (&&) placed before the exact name of a global
variable will display the content of this variable (ex. :
&&gb_MyVariable)

&&MusicVolume The current value of the music volume (0 – 100).

&&MusicName The name of the music playing, if any.

See the “Statistic system” section for more information on the battle statistics use.

Automatic events

There are 23 events that are automatically executed by the engine on precise occasions. The engine
will recognize these events by their name and call them at the appropriate time. Most events are
optional (otherwise stated).  Here’s the complete list.

Main Required. Probably the most important event of your game. This event is
executed immediately after the last player creation dialog has been closed (if
any). After the end of this event, the player must have been sent (by a
“Teleport” event action) to a Location, where his adventure will begin.

StartGame This event is executed only one time, when the game is started. This is the first
thing that is called after the game application itself has finished starting up.

NewGame This event is executed when a new game is started, before the player creation
dialogs (if any) appear.

EndGame This event is executed when the game ends and/or the player die. You may use
a conditional event action checking whether the player’s stamina is greater than
0, in order to determine whether he died, or whether your game just called an
“Engine call” action with the “Close game” option.

OpenGameEnter This event is executed before the open game dialog is displayed.

SaveGameEnter This event is executed before the save game dialog is displayed.

OpenGameExit This event is executed after the open game dialog is displayed.

SaveGameExit This event is executed after the save game dialog is displayed.

QuitGame This event is executed only one time, when the player quits the application.

MapPortrait This event is executed when the player clicks on the player picture of the map
layout. You could use it to display the player statistics sheet for example.

MapButton1,
MapButton2,
[…]
MapButton10

These events are executed when the player clicks on one of the ten special
button zones of the map layout (see the map layout in the game options).

MainPortrait This event is executed when the player clicks on the player picture of the main
layout.

MainButton1,
MainButton2,
[…]
MainButton10

These events are executed when the player clicks on one of the ten special
button zones of the main layout (see the main layout in the game options).
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Item editor

During the game the player will probably have to gather items in shops or for his quest. Coldstone
puts at your disposal a powerful and complete item editor.

How to create an item

Select the command “New -> Item” from the “File” menu or click on the corresponding button in the
tool window. A blank item editor will appear.

Item types

Coldstone distinguishes nine different types of items: weapons,
armor, shields, gauntlets, boots, belts, helmets, various objects,
and special items.

The first seven types are standard clothes and adventure
equipment. They modify the player’s statistics only when he
wears them. When he unequips one of those objects, he loses
all the benefits of the object.

The various objects are items that the player cannot wear. They can only be used or dropped. When
they are used, their statistics modifications are applied to the character permanently. The item will
then disappear from the player’s inventory. However, if you have specified a condition for the
“Drop” action (see the “Links” panel below) and this condition is evaluated as being false, the item
will not be dropped from your inventory after being used. If you have specified an event link for the
“Drop” action, it will be executed if there is either no condition specified or the condition is evaluated
as being true.

Special objects are items that the player can’t wear. These items can’t be sold at a shop. They can
only be used or dropped. Their use has absolutely no effect but to launch linked events. This type of
object will often be used to represent important objects that are linked to the story line.

Note: An item with a price equal to 0 can’t be sold at a shop, no matter what type it is.

Item editor interface

The item editor and its quantity of options and parameters can appear impressive. No less than four
panels are needed to display all the options for one item. By offering you this panoply of options,
Coldstone gives you almost unlimited possibilities. In fact, you will rarely have to use all these
parameters.
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Choose the item’s
type.

Modifications to the
player’s statistics.

Note: When the item
can be equipped, the
“Stamina” and “Magic”
field modify their
maximum value (until
unequipped). When
this is a various item,
this modifies the
current value once
permanently.

If the item is a range
weapon, you must
select the kind of
animation to do when
the player attacks with
it and what picture to
use for the animation.

The type of damage
dealt by this item.

The description of this
item that will be
displayed in the “Item
description” zone of
the “Shop” and
“Inventory” layouts
(see “Layout types”
for more information).

The picture used to
display the item when
it appears on a map.

The picture used to display the item after the
player has used it (i.e. clicked/walked on it). If this
field is left empty, the item will be removed.

The item can be
“used” on a map only
this condition is
evaluated as being
true. If so, the action
link will be
automatically

Item’s range.
Considered to be a
ranged item if greater
than 0.

If the “Block” option is
checked, the item will
block access to the
player on the map.

Check “Remember
use” to make this item
usable only once in
the whole game.

Check “Take when
used” to automatically
add this item to the
player’s inventory
when “used” on a
map.

When used in
encounter against an
opponent:
• Minimum amount

of damage
• Maximum amount

of damage
• Damage bonus

(will be added to
the final damage)

• The amount of
protection (added
to the character’s
armor)

Number of hands
which this weapon or
shield occupies.

Normal price of this
item.

Size of the item.
Determines which
character classes can
equip it.

Select if the item
should appear under
the player (“Back”),
sorted with the player
(“Normal”), or above
him (“Above All”).
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Each item type has its own list of actions. This
list corresponds to all that the player can do with
this object.

It’s possible to assign a sound, an event, and an
execution condition for each action.

The sound will be played each time the player
executes the action. Likewise, the event link will
be called. The condition lets you enable or disable
the ability of the player to perform that action.
To add a condition or modify the current
condition, click on the “Condition” button, same
thing for the event link. To remove the condition
or event click on the “X” button. The event links
are locals (saved in the item file).

To change the attributes of an action, select it
from the list. The action’s attributes will be
automatically displayed at the bottom of the list.

Protection against the different types of damage
(in percent). See the “Magic Resistance” section
for more information.

Check this box if you want that item to be
cursed.

When the player uses or equips the cursed item,
the parameters of the “true item” will be used!
Note: while it’s more logical to have the true
item be of the same type as the cursed item,
Coldstone can handle different types as well.

Check the box “Item is magical” if you want that
item to be magical (only available to characters
whose class permits them to use magical items).

Check the “Item stores a spell” option to assign a
spell to this item. Select it from the spell list pop-
up menu and specify how many times the spell
can be cast (-1 means infinite).

Use the pop-up menu (whose contents vary
depending on the item type) to select the action
that will cast the selected spell from the list
(which varies depending on the item’s type).
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With the class editor, Coldstone lets you restrict
the items available to each class. You can thus
decide that warriors will not be able to use ranged
weapons and that spell users will be limited to light
weapons. However, you may want your warrior to
be able to use a special bow (ranged weapon) that
he gained from a long and death-defying quest. You
could also desire an ultimate weapon, needed to
annihilate the final monster, could be used by
characters of any class. This also applies to the
other types of items that the character can equip.

To override the class restrictions on this kind of
item, check the box next to the classes which you
want to guarantee use of this item.

Note: Most of the time, you will not have to use
this list. A class that is not checked will be able to
use this item if its parameters allow it (see the
class editor).

All item types have a default picture (see “Layout
types” section) that will be displayed next to their
name both in the player’s inventory and in shops.
However, you may want to assign different pictures
to some special items in your game. To do so,
check the “Override…” option and select a picture
by pressing the “…” button.

Note: Inventory items only support still pictures
not animation files.
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Non-player character editor

The non-player characters (also called NPCs) represent the people and creatures that the player will
meet during the game. They have a lot of common characteristics with the player (i.e. they have
battle statistics, an inventory and spells).

How to create an NPC

Select the command “New -> NPC” from the “File” menu or click on the corresponding button in the
tool window. A blank NPC editor will appear.

Aggressive VS Passive NPCs

NPCs in Coldstone may be either passive or aggressive. An aggressive NPC will always attack the
player when he is nearby; a passive NPC (such as a villager) will never attack the player, and cannot
be attacked by the player. An aggressive NPC will track the player on sight (payer within his LOS, see
below) and will stop tracking if the player outruns him (player at a range greater than his LOS). To
create a passive NPC, set its stamina to 0.

NPC Editor interface
Quickly generate a
character sheet based on
the character’s level. Will
randomly generate all
statistics on this panel.

The minimum and
maximum amount of base
damage that can be done
by the character per
strike. This damage is
added to the damage
dealt by any weapon that
the NPC uses.

The type of base damage
caused by the character
in melee.

Base protection of the
character against
damage.

The number of
experience points (xp)
and gold pieces (gold)
that the player will
receive after defeating
this character.

The number of milliseconds (1000 = 1
seconds) that this character must wait
between two attacks.

Character’s level,
used to generate
the statistics when
you hit the “Roll”
button. The higher
it is, the better the
statistics will be.

Stamina points of
the character.
When they drop to
0 during the game,
the character dies.
If set to zero from
the start, the NPC
is passive (see
above).

Magic points of the
character. Each
spell needs a
specific amount of
magic points to
cast.

Character’s
statistics (see
“Statistics
system”).

The NPC's line of sight. When a character
hostile to this NPC is within this range,
the NPC will switch to battle mode.
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Check all the items that should be in the
character’s inventory from this list (the
contents of your items folder).

They will try to equip an item of each
possible piece of equipment. If there is
more than one item of a specific type, it
will equip the best of the two. Coldstone
use a very simple equation to know if an
item is better than an other. The
comparison value is equal to the sum of
the damage, protection and statistic
modifiers numbers.

You can view and edit any of the items by
double-clicking on its name in the list.

The percentage of magic damage that the
character can absorb of each type.

Select the picture that will
represent the character in
a map. A preview of the
selected picture is shown
on the left.

The behavior of the character in battle. A complete description of
each artificial intelligence scheme is provided. Simply click on any
scheme to view the description in the right field.

Check all the spells that should be in the
spell book of your character from the list
(the contents of your spells folder).

You can view and edit any of the items by
double-clicking on its name in the list.
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Note: Hostile characters may leave the max range radius when chasing the player during a battle.
However, if the player escapes the character, it will immediately seek to return to an area within its
original movement radius.

The “Target proximity” event is executed when the target (player or cell) is next to the NPC
(range of 1). The “Target reached” event is executed when the NPC stands on the target
cell. The “Player contact” event is executed when the player intentionally move toward the
NPC (touch it). The “Death” event is executed when the NPC is killed.

These are local event links (saved in the NPC file). Click the edit button to modify the event
and the “X” button to clear it. When an event contains at least one action, the edit button
caption will appear in bold.

How many milliseconds the NPC will
wait between two moves (its speed
on the map).

How far away the NPC can move
from its initial position on the map
(max movement radius). The
maximum movement region is
calculated as a square around the
initial position. NPCs with any
movement type other than "Walk
around initial position" are not
constrained by their movement
radius.

The movement pattern of the NPC
while not in battle. You can
make it walk randomly around its
initial position (for town people for
example). You could also make it
walk toward the player or another
specific cell. Choose the “Escape
player” option to make it always
seek to move away from the player.
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Race editor

When the player starts a new game, you can let him choose his race (i.e. his origin, country, etc.). The
list of races that appears comes directly from your “Players:Races” folder.

How to create a race

Select the command “New -> Race” from the “File” menu or click on the corresponding button in the
tool window. A blank race editor will appear.

Race editor interface

This race’s description. This description
will be displayed when the player starts a
new game, in the “Description” field of
the race dialog (see the race dialog
layout).

These statistics modifications will be
applied once, when the player starts the
game. You can specify a positive or
negative value that will be added to their
basic roll.

For more information on statistics, check
the “Statistics System” section.
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Class Editor

When the player starts a new game, you can let him choose his class (i.e. his specialty, profession,
etc.).  The list of classes that appears comes directly from your “Players:Classes” folder.

How to create a class

Select the command “New -> Class” from the “File” menu or click on the corresponding button in the
tool window. A blank class editor will appear.

Class editor interface

The class editor is similar in several points to the race editor. This is why we will not detail here all the
elements of the window (refer to the section “Race editor interface” above).

You must assign a skill table to each
class. This skill table will define the
amount of experience needed for a player
of this class to gain a level.

This button opens the linked skill table
that has the same file name as this class
in the “Players:Skill Tables” folder. If no
skill table of this name exists, Coldstone
will create one for you.

Check in the spell list those spells that
you want the player of this class to be
able to cast.

Double-click on any spell name to open it
in the spell editor.

The categories (dimensions) of the
weapons and armors that a player of this
class will be able to use.

Weapons:
S = small weapons
M= medium weapons
H=  heavy weapons
R= ranged weapons

Armors:
S= small armor
M= medium armor
H= heavy armor

Check this to allow the
player to use “magical”
items (see the “Item
Editor” section).
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Skill table editor

Skill tables are used to determine when the player of a particular class (the class of the same name as
the skill table) will gain a level. It is possible to link the level accomplishment to an event.

How to create a skill table

Select the command “New -> SkillTable” from the “File” menu or click on the corresponding button in
the tool window. A blank skill table editor will appear.

Skill table interface

You must specify an amount of
experience points (xp) that the
player of the associated class will
have to gain to reach the first 20
levels.

The next level (higher than 20) will
be automatically calculated with the
multiplication factor.

The multiplication factor makes it
possible for Coldstone to calculate
the amount of experience points
needed to reach levels above 20. As
a result, the player will be able to
have unlimited levels.

Thus the experience points
necessary for obtaining level 21 will
be equal to:

Level21 = ((Level20 – Level19) *
factor) + Level20

This button makes it possible to automatically calculate the value of the first 20 levels starting
from the first with  the multiplication factor. The difference between a level and the previous one
multiplied by 1.4 will give the amount of new experience points needed to reach the next level.



Coldstone™ User Manual by Beenox inc. ©1999-2001 Beenox inc. All rights reserved. 59

At each level, an event can be linked. This event will be automatically launched by the engine when
the player reaches that level. When the event is executed, the player has already gained the level so
if you check the “Level” value of the player, it will be equal to the new gained level. Also, if you want
to have an event executed each time the player gains a level, create an event linked to level 0. If such
an event link exists, it will be executed before any other. If after executing an event link the player
stamina is equal or less than zero, no more event links are executed.

Open the selected event in
the event editor.

Clear all the events from the
list.

This list displays all the links
between the events and the
levels. The level is shown in
the left column and the name
of the event linked to this
level is shown in the right
column.

To link an event to a level, the
event must have been
previously created and placed
in the “Defs” folder in the
“Events” folder.

Add a new
event linked to
a level gain.

Clear the
selected
event.

Modify  the
selected
event.
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Spell editor

Spells are incantations which the player or characters can cast during a battle or elsewhere. Spells can
produce various effects, of an offensive or defensive nature.

How to create a spell

Select the command “New -> Spell” from the “File” menu or click on the corresponding button in the
tool window. A blank spell  editor will appear.

Spell editor interface

The description that will
appear when the player
selects this spell.

Level: the level of this
spell used for reference,
see the “Spell selection”
action type.
Cost: The cost in magic
points to cast this spell.
Duration: The duration of
the spell in battle rounds.
One round lasts for about
2 seconds.

Used only in the
artificial
intelligence
schemes to
distinguish if this spell
is of offensive (battle)
or defensive
(protection) nature.

The target type allowed.

Caster: The spell affects
only the caster.
Allies: The spell affects
the characters allied with
the caster.
Enemies: The spell
affects the characters
that are NOT allied with
the caster.
Single character: The
caster must pick a target
himself by clicking on it.

The minimum and
maximum amount of
damage that the spell
does.

The damage type must
be specified. The target
will use its magical
protection against it
(see the “The statistic
system” section).

If the “Damage each
round” option is
checked, the target will
receive damage each
round (duration). If the
“Repeat animation” is
checked, the animation
specified below will
appear again above the
target each round.

Minimum and maximum distance
between the caster and his target(s).

Only the targets in this range can be
affected by this spell no matter what
target type is selected.

The animation type that will be used when the player or character
casts this spell. Three choices are available:

- A bullet from the caster to the target
- A picture directly displayed over the target
- No visual effect
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All the modifications will be directly
applied to the target’s statistics during a
specific number of turns that you specify
in the “Duration” field (under the
“General” tab). These modifications are
temporary and will only be applied once
even if you checked the “Damage each
round” option.

You can specify either a negative or
positive value according to whether you
wish to penalize or improve the target.

Refer to the “The statistic system”
section for more details on the different
kinds of attributes.

Allows you to specify a condition for casting
the spell. The player will be able to cast this
spell   only if this condition is true (or if
there is no condition specified). You could
thus limit a spell to players that have a
wisdom greater than 16, for example.

Click on this button to specify or modify a
condition. The “X” button lets you clear the
current condition if any.

Like items, spells can have events linked to
one or more of the actions that can be
accomplished by the player with them.

Consequently, you can create a whole
variety of spells. For example, it would be
possible to create a spell that opens a
location that displays a map of the world.
The player would then be able to click in this
map to teleport himself to the selected city.

Link an event: click on the edit button. If the
event contains at least one action, the edit
button caption will appear in bold.

Remove the link of an action: click on the
action to be cleared and click on the “X”
button.
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Animation editor

Lot of elements in Coldstone need to have an image associated in order to be displayed in your game
(i.e. items, characters, map objects, etc.). Coldstone gives you the power to use a standard still
picture or an animation in most of these cases. The animation editor lets you create traditional
animations (simple series of pictures displayed one after another) as well as motion paths with bezier
and linear interpolation support.

How to create an animation file

Select the command “New -> Animation” from the “File” menu or click on the corresponding button in
the tool window. A blank animation editor will appear.

Animation editor interface

Add a new frame
at the end of the
current
animation.

Duplicate the
selected frame.

Delete the
selected frame.

Edit the selected
frame’s attributes
(flag and
parameters).

If checked, this
frame is
considered as a
key frame.

Display the
frame’s flag (if
any) .

List of all the
animations within
this animation file
with the standard
new, duplicate,
delete and edit
controls which
operate on the
current selection.

Move the
selected frame
up and down in
the list.

Key frame
interpolation
control.

Center the
selection in
the viewer.

Let you preview
the current
animation (either
a single time or
in loop).

Select the
type of the
current
animation.

Slide
through the
current
animation
frames.

The number of
refreshes skipped
in the engine
between two
frames.

Animation
viewer

Let you modify
the key frame (or
selection) edition
mode.
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Creating a new animation

An animation is made of a series of frames. When you first open an animation window, the frame list is
empty. You must first add at least one frame to the animation. To do so, click the “Add” button at the
top of the list. The tile set browser will appear displaying the content of your “Pictures” folder. Browse
through the list and select the picture you want. Click the “OK” button to validate your choice and
close the dialog. The name of the picture will appear in the frame list, to the left. Repeat these steps
until you have all the different pictures of your animation loaded. Click on the “Play” button (under the
frame list) to preview your animation.

Note: You can also drag and drop files from the Finder in the frame list (the files must be in your
“Pictures” folder).

Your game refreshes the screen 30 times per second and each time, it will increment the current
frame of all the loaded animations by one. If you want your animation’s frames to last longer than one
frame at the screen, just change the value of the “Frame delay” field in the bottom right of the
animation window. The default value is 0 which means that it will never wait. If you enter 3 in this
field, for example, your animation’s frames will remain on your screen for 4 refreshes (displayed in one
refresh, then waiting for 3 more), thus making the animation play “slower”.

Frame flags

You should now be able to create a traditional animation. There is only one problem: the animation
doesn’t loop i.e. it plays only one time. Here come the frame flags. Each frame can have one flag
associated to it as well as flag parameters. Click on any of the frames in the frame list and click the
“Edit” button above the list (you can also double-click on the frame). This dialog will appear:

You can then select a flag for this frame (or remove an existing one by selecting “None”). Here are
the complete flag descriptions:

1. Set marker Set the frame at which to loop when reaching a frame with flag 2.

2. Loop to last marker Loop to frame previously set with flag 1.

3. Play sound Play a sound from your “Sounds” folder. Requires the name of the sound to
be entered in the parameters field.

4. Launch sprite Launch another animation/picture at the same coordinates as this animation.
The first parameter is the path to the animation (you can use the “Select a
sprite…”  button to pick a picture or animation).  You can also specify the
initial x and y offset of the new sprite as the second and third parameter.
Ex.: These parameters: “Smoke.pct,15,50” called by a sprite at coordinates
(50,50) will add the picture “Smoke.pct” (found in the “Pictures” directory
of your game folder) to the current map at coordinates (65,100). This new
sprite will be completely independent of the animation that launched

List of all the frame flag types. You can select
only one flag for each frame.

Some flag types may require additional
parameters (like the sound name if you select
the “Play sound” flag).
If you have to specify multiple parameters,
you must separate them with a comma (,).
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it.

5. Kill myself Remove this animation (sprite) from the map.

6. Launch an event Execute an event from your “Events:Defs” folder. Requires the name of the
event to be entered in the parameters field.

7. Offset position This flag takes two parameters (x,y coordinates) that will be added to the
animation origin. Ex.: if an animation is placed at (230,100) on a map and
you call this flag with the parameters “20,10”, the sprite will now appear at
(250,110) on the map.

8. Switch animation Change the current animation for the one specified in the parameters field.
You must enter the index of the animation to switch for (see the animation
popup menu under the frame list).

9. Switch to random
animation

Choose a random animation in the animation list and switch to it. If you leave
the parameters field empty, it will randomly choose an animation from your
whole list. You can specify from which animation to choose from by putting
them all in the list, separated by a coma “,”. Ex.: if you put “0,2” in the
parameters field, the engine will either switch to the animation index 0 or
index 2.

10. Camera Lock Lock the camera on this animation. The animation will become the new
center reference for the engine. This flag takes two parameters: an
interpolation value and the origin reference. The interpolation is how many
steps the camera will take to go from its actual position to this new position.
A step of 0 or 1 will immediately change the camera center while a greater
value will result in a smoother transition. The second parameter must be
equal to 0 or 1. If it’s equal to 0, it will follow the offset of each animation
frame. If equal to 1, it will stick to its origin.

11. Camera Unlock Unlock the camera from any previously locked animation and re-center it on
the player. This flag takes only one parameter, the interpolation value (see
above).

So if you want to make your animation loop, you will need to set the flag of your first frame to 1 (Set
marker) and the flag of your last frame to 2 (Loop to last marker).

Animation types

Coldstone supports four types of animation: standard, directional 4, directional 8, and 360 rotation.

Standard Standard animations are just what you think they are: standard. Once
started, they will be displayed one frame after another and your game will
execute any flag associated with their frames.

Directional 4
Directional 8

Directional 8 animations are meaningful only for characters and items. They
should contains at least one frame of the character facing each of the 8
directions in a very specific order (starting from top):

• North
• North East
• East
• South East
• South
• South West
• West
• North West

When your game will have to display an animation of type directional for one
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character it will first determine which of the 8 directions should face the
character. It will then divide the total number of frames by 8 to know how
many frames should be displayed by direction. It will finally find the starting
frame for this direction. You still have to add loop flags if you want
your directional animation to loop (you will have to set multiple flags for one
animation since it is played by segment).

A directional 4 animation is the same thing but only requires the North, East,
South, West directions specified.

Note: A character with a directional 4 animation will never walk diagonally.
It’s also true for the player.

360 rotation These are meaningful only for ranged weapons and spells (in all other cases,
they are treated identically to a Standard animation). They may contain as
many frames as you like to represent a 360 degree rotation starting at 0
degrees, i.e. north. When your game displays such an animation it will find
which direction the animation should face and will display the correct frame
in the list (0 degree is the first frame and then clockwise to 359 degree).
Use this for arrows, for example, to add realism.

Automatic animation switch for non-player characters

There are some situations where the engine will automatically switch the current animation for the
player and the NPCs (if they use an animation file, not a still picture) to a specific animation ID if this
ID is available. The animation index is displayed in the popup menu found under the frame list in the
animation editor. It represents the order of the animations within the animation file.

Index 0 Walk animation The engine will use this animation when the character walks
around in a map.

Index 1 Attack animation The engine will automatically switch to this animation when the
character attacks an opponent with a weapon whose range is
smaller or equal to 1.
Important: the animation (or segment of animation if it’s a
directional animation) should end with a “Switch Animation” flag
(flag 8) with parameter “0” to return to the walk cycle
animation.

Index 2 Range/Magic
attack animation

The engine will automatically switch to this animation when the
character attacks an opponent with a weapon whose range is
greater than 1 or when the character casts a spell.
Important: like the normal attack animation, it should end with
a “Switch Animation” flag (flag 8) with parameter “0” to return
to the walk cycle animation.
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Automatic animation switch for the player

A player animation can have the same animations has mentioned above but also have a “Block”
animation. The order of the player animations is:

Index 0 Walk animation

Index 1 Attack animation

Index 2 Block animation The engine will automatically switch to this animation when the
character blocks (by pressing the “Z” key or by pressing the
right mouse button on Windows).

Index 3 Range/Magic
attack animation

Note: If you don’t want to use a particular kind of animation (like the range attack) for a character,
you could use the duplicate button next to the animation popup menu to quickly create a copy of the
attack animation.
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Motion paths

A frame has not only a picture and a flag associated to it but also a position. For simplicity, the
default position of all frames is 0.  More advanced users may want to add motion paths to their
animation. Those are particularly useful when you want to create something like smoke coming out of
a house or a butterfly flying around the village.

Before starting to create your first animation path, you must be introduced to the fundamentals:
keyframes. A keyframe act as a reference frame for the editor. Only keyframes can have a position
while all other frames’ position are automatically calculated by the editor. Imagine yourself drawing
two dots on a piece of paper. Let say that these two dots are two keyframes placed at frame 0 and 4.
Now draw a line between those two keyframes. You can now find the position of all other frames
automatically by splitting the line in 4 equal parts. Congratulations, you’ve just discovered what linear
interpolation is.

Now, create an animation of 10 frames (can be the same frame duplicated). To create a new
keyframe, simply check the box next to the frame you want. So create a keyframe at frame 0 and
frame 10. Be sure to have the frame 10 selected and click on the red dot that will appear on the
animation viewer, to the right. Hold down the mouse button and drag the key frame somewhere far
enough from the center. See? All the frames between the keyframes are displayed as small gray dots.
You can move your keyframe around and their position is updated automatically! To delete a key
frame, simply uncheck the box. You can preview your new animation by pressing the “Play” button
below the frame list.

Keyframe

Keyframe
2

1

3
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Bezier interpolation

In the last paragraph, you were introduced to linear interpolation (straight line between two
keyframes). This is great but more advanced users might want to have more control over the
interpolation to create more fluid animation. Luckily, Coldstone gives you the possibility to use bezier
curves for interpolation. Bezier curves need additional points (called control points) to define their
shape.

Select both two keyframes that you created in the last section (by clicking in the viewer and dragging

to include the two keyframes in your selection). Now click on the  button, above the viewer. You
will see 4 new points on your screen, which are those control points mentioned above. Move these
new points (blue and green) around and you will see that you can now have much more control.

Bezier interpolation example

You will notice that there are two control points of two different colors for each of the keyframes. The
blue control points control the left part of the curve (if you try to move these control points on the
first keyframe, you will notice that it doesn’t do anything) while the green ones control the right part.
You can move the two in parallel if you hold shift while clicking one of the control points to move.

Coldstone’s animation editor can also mix the two interpolation systems. To do so, simply use one of
those button to set the interpolation mode of the selected keyframe(s):

Linear interpolation for the parts to the left and to the right of the keyframe

Linear interpolation for the part to the left and bezier for the part to the right of the keyframe

Bezier interpolation for the part to the left and linear for the part to the right of the keyframe

Bezier interpolation for the parts to the left and to the right of the keyframe

Using the animation viewer

To select a keyframe Either click on it in the viewer or select it in the frame list.

To select multiple
keyframes

You can simply click on all keyframes one after another in the viewer. You
can also click in the viewer (not on a key frame) and drag the cursor while
holding the mouse button. Drag the cursor so that all the keyframes you
want are included in the box and release the mouse button.

To deselect a keyframe Click on it in the viewer or click where there is no keyframe.

To scroll the view Click and hold the mouse button while holding the command key down. Move
your cursor around to scroll the view. Use the “Center” button above the
viewer to center the view again.
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Positioning characters

The character animation origin will be centered in the tile on which the character is standing. If you
want to have your character look like he is actually on the correct tile, you must center his feet (or
anything he has that must lie on the ground) at 0,0 in the viewer. You must do it by creating a
keyframe at the first frame of your animation and moving the frame so that your character is
“standing” at the intersection of both axes:

Collision sphere

When the engine needs to evaluate if the path across a gang of other characters is possible, it will
check the player collision sphere against the other characters’ spheres. If they collide, this way is
blocked. This sphere is also used to know if a missile weapon has reached a target. To define a
collision sphere for your character animation,  you must first check the “Collision” box in the editor
and specifiy the sphere center as well as its radius.

Note: You can directly specify a collision sphere by holding down the shift key and clicking in the
animation viewer. Hold the mouse button and move your cursor around to scale the sphere (the old
one will be displayed as a reference until you release the mouse button).
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Game options

The elements of a game can be divided into 2 parts: the contents and the container. Now that you know how
to create the contents (see the “Editors” sections), it’s time to specify global parameters (i.e. parameters
that affect the entire game). Coldstone gives you the ability to change most of a game’s aspects, such as the
interface, menus and other things. To do so, you must open the game options dialog using the “Game
Options” command under the “Project” menu. The dialog is divided into 6 panels: layouts, menus, keydown
events, event globals, plugin options and miscellaneous options.

Interface Layouts

Interface layouts let you define the aspect of all the windows in detail. Thus you can specify the
background picture and the position and size of all the buttons and text fields. This is not available in
plugin development mode.

Add or modify the background picture of a window

A list displays all the windows used by your
game. Click on the interface layout that you
want to modify.

You must first specify a background picture
to use by clicking on the “Select” button.
Once the picture has been selected, it is
displayed in the window layout preview zone.
You can change the background picture at
any time (by clicking again on the “Select”
button) without losing your other layout
modifications.

To edit the position and the size of the
layout’s different zones, you must click on
the “Edit” button17 or double-click on the
layout name in the list. The layout editor will
appear.

                                                
17 If the button is not enabled, it is because you did not specify a background picture for this layout (or the specified picture is
invalid).
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The layout editor

This window lets you modify the size and position of all the zones in your interface layouts. A series
of rectangles are displayed over the background picture linked to the current layout. Each rectangle
corresponds to an element (button, text field, etc.) that must be in the game window. The name of
all the zones is displayed inside their rectangle so that you can easily see the use of each of them.

Tip: If you don’t want one or more of the zones to be displayed in your game, just move it outside
the screen so that it is not visible. You will still be able to select it by using the left arrow and right
arrow buttons.

The coordinates
of the mouse
cursor relative
to the
background
picture.

The position and
size of the
selected zone.
You can modify
these fields
directly for more
accuracy.

These two buttons let you modify the order of the
zones. This has absolutely no impact on your game.
This is only to facilitate the interface layout edition.
The “Front” button brings the current zone to the
front, over all the other zones. The “Back” button
has the inverse function. It sends the current zone to
the back, under all the other zones.

The rectangle
of the current
zone appears in
red.

Move a zone: click inside the rectangle and drag it to the desired location.
You can also use the arrows on your keyboard to move it.
Resize a zone: Click in the bottom right corner (the cursor will change) and
drag it to grow or shrink the rectangle. You can also use the arrows on your
keyboard while pressing the shift key.

The name of the
selected zone. You
can navigate
between the zones
with the left arrow
and  right arrow
buttons. You can
also select a zone
directly from the
popup menu.

Save the
modifications and
close the layout
editor.
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The layout types

Here is a description of each layout type:

About box In any game made with Coldstone, the system menu (Apple menu for
Macintosh users) will always display at least one menu item named
“About…”. When the player selects it, this picture is displayed (a simple
click will close it).

Class Dialog This window is displayed at the beginning of a game to let the player
choose a class. The “Class list” zone will display a list with the name of
all the classes found in the “Players:Classes” folder of your game folder.
When a class is selected, its description will appear in the “Description”
zone, over the background picture.

Dialog This window is displayed when an action of type “Dialog” is called with
text and/or answer choices. The “Log button” zone determines where
the player has to click to log the text of this dialog into his journal (see
the “Journal” layout). Journal entries are saved in the save game files.

Dialog Entry This window is displayed when an action of type “Dialog Entry” is called
to ask the player for a text input.

Inventory This is the window that displays the player’s inventory and the
equipment that he is wearing at the moment. It also displays the amount
of gold in hand as well as other attributes. Use an action of type “Engine
Call” to display the statistics window.

Journal This window is displayed when an action of type “Engine call” is called
with the “Open player’s journal” option. It will let the player look at what
he has logged into his journal (see the “Dialog” layout).

Level Up This is the window that is displayed when the player gains a level during
the game (see the “Statistic system” section for more information on
gaining levels).

Loading dialog This window will be displayed when the game starts and each time a map
is loaded. The “Progress bar” zone will display a standard progress bar
control and the “Progress status text” will display the loading status over
the background picture.

Main Interface The background used when displaying a location of type “Main” that has
the option “Use interface” enabled. This layout will only be used
when a game is in progress. The most important zone is the
“Game area”. This is where the main location picture will appear. There
are also a couple of other zones available to display the player attributes
in real time.

Map Interface This layout is the exact same thing as the “Main Interface” layout except
that the “Game area” zone is used to display the current “Map” location.

Map Mask Optional. This picture is used to handle transparency within the map
interface for the game area display. Only the intersection of the game
area zone and the pure black region of the map mask will appear on the
player’s screen. If you don’t specify a mask, the map area will be drawn
in the “Game area” zone of the map layout without any masking (simple
rectangle).

Map Overview This window is displayed when an action of type “Map Overview Display”
is called. The map location picture will appear in the “Map Overview”
zone (a simple click will close it).

Name Dialog This window is displayed at the beginning of a game (when an action of
type “Engine Call” is executed with the parameter “New game”) to let
the player choose his name. This window will appear only if you checked
the “Show the name dialog” option under the “Misc” panel in the game
options. The default player name (also specified in the game options) will
appear in the text field.
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Plugin Dialog If you have decided to allow plugin development for your game (and
decided to ask the user, not automatically load everything), this window
will be displayed if there is at least one plugin in the “Plugins” folder to
allow the player to pick which plugins he wants to load.

Race Dialog This layout is the exact same thing as the “Class Dialog” layout except
that it lets the player choose a race instead.

Scrollbar skin The picture used to display the scrollbar of the lists in the inventory,
shops and spell windows. See the “Scrollbar skin” section below for more
information on how to create your own skin.

Shop This window is displayed when a location of type “Shop” is opened (with
an action of type “Teleport” for example). The “Item List” zone will
display a list of all the items available at this shop by default. The player
can switch between the shop inventory and his own by clicking on the
“Shop Items Button” and “Player Items Button” zones. This way, he can
buy and sell objects.

Spell Cast This window is displayed when an action of type “Engine call” is called
with the “Open player’s spell dialog” option. It will let the player select a
spell to cast.

Spell Selection This window is displayed when an action of type “Spell Selection” is
called within an event to let the player select a certain number of spells
to add to his spell book.

Statistics This is the window that displays all the statistic values of the player
(stamina points, strength, etc.). For more information on the meaning of
these values, refer to the “Statistic system” section. Use an action of
type “Engine Call” to display the statistics window. This window will also
be displayed at the very end of the player creation process (i.e. after the
name, race and class window) if the “Show statistics…” option found
under the “Misc” tab in the game options  is checked. It is only at this
particular occasion that the “Reroll button” zone will be used to display a
standard button to let the player regenerate his statistics randomly.

Task list This window displays all the tasks that the player currently has.  You can
modify the task list content with an action of type “Task list Control”.

Item Weapon The default picture displayed next to items of type “Weapon” in the item
list of the inventory window.

Item Armor The default picture displayed next to items of type “Armor” in the item
list of the inventory window.

Item Shield The default picture displayed next to items of type “Shield” in the item
list of the inventory window.

Item Gauntlets The default picture displayed next to items of type “Gauntlets” in the
item list of the inventory window.

Item Boots The default picture displayed next to items of type “Boots” in the item
list of the inventory window.

Item Belt The default picture displayed next to items of type “Belt” in the item list
of the inventory window.

Item Various The default picture displayed next to items of type “Various” in the item
list of the inventory window.

Item Special The default picture displayed next to items of type “Special” in the item
list of the inventory window.

Item Helmet The default picture displayed next to items of type “Helmet” in the item
list of the inventory window.
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Scrollbar skin

The Coldstone engine uses custom list controls in various windows to display a list of objects (such as
the items in the inventory and shop window). When the number of objects exceed the height of the
list, it will display a scroll bar. This scroll bar is drawn using the picture specified in the “Scrollbar skin”
layout:

The picture is divided in 8 portions. The skin supports
transparency and may be of any width or height as long as each
portion has an equal height.

1. Top scrollbar arrow.
2. Top scrollbar arrow when clicked.
3. Background bar when the user clicked in it.
4. Slider when the user is holding the mouse button over it.
5. Slider in idle state.
6. Background bar when in idle state.
7. Bottom scrollbar arrow when clicked.
8. Bottom scrollbar arrow.

A scrollbar skin with a
standard look.

A more game friendly
scrollbar.
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Custom menus

Coldstone lets you modify the standard menus of the game engine: the system menu (Apple menu),
“File” menu and “Game” menu. You can add commands in each of these menus. These commands will
automatically execute the event that you have linked to them.

The commands in the system menu will be added immediately after the command “About…” already
there. The commands in the file menu will be added before the command “Quit”. A separator will be
automatically added if there is at least one custom command in the file menu. Finally, the game menu
contains only the commands that you have added. If there is no command added to the game menu,
it won’t appear in the menu bar.

The only menu commands automatically added by the engine are the “Quit” command of the file
menu and the “About…” command of the system menu.

Note: To create a keyboard shortcut for a menu, add a slash followed by the shortcut character to
the menu item name (example:  “New Game/N”). If you want to add a menu separator, add a
command named “-“.

Select from the list the
menu that you want to
modify.

Click on the “+” button to
add a command to the
current menu or click on
the “-” button to delete
the selected command.

Use these buttons to move
the selected command up
or down in the list.
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Global keydown events

Global keydown events make it possible to bind an event to a key press. Events will be launched each
time the player presses this key, at any location in the game (except if this location does not accept
global keydown events - see the “Location Editor” section). The specified key can be sensitive to the
upper and lower case letters. When a key is not “case sensitive”, the upper case and lower case keys
will be regarded as the same key. So, if the key is “case sensitive”, the key “a” and “A” will be
regarded as two different keys.

Click on the “+” button to
add a keydown event or on
the “-” button to delete
the selected event.

Contains all the global
keydown events that you
have defined.
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Global event variables

Event variables are used to store various values on the status of the game. It is with these variables
that the creator of the game will be able to direct the player into an event rather than another (if one
does not meet certain criteria). The number of these variables is unlimited. Each variable has a unique
name, preceded by “gb _”. When the game begins, all the variables are empty.

Creating a global variable

Modifying a global variable

To modify the contents of a global variable, you have to use an action of type “Change Globals”.
Choose the variable to modify, select the kind of modification (replace, add, subtract, multiply or
divide) and select the value for this modification.

If a global variable has a value of 5 and you execute an action of type “Change Globals” with, as
parameters, an addition with a value of 2 (add), the new value of this global variable would be 7 after
the execution.

Testing a global variable

The global variables have the principal utility to make it possible to influence the execution of an
event. It is with an action of the type “Conditional” that you will be able to do an action rather  than
another according to the value of a global variable. If for example you wish that a character rewards
the player if this one visited a place in particular, you will use an global variable. When the player visits
this place, you change the value of this variable to 1 (otherwise it is 0). When the event of the
character starts, you test the value of the variable. If it is equal to zero, you display the usual
dialogue if not, you display the dialogue of reward (or other thing).

To create a new global
variable, simply click on
the “+” button and enter
its name in the dialog box.
The prefix “gb_” is
automatically added by
the editor.

All the global variables that
you define are displayed in
this list.
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Plugin development options

As the creator of the original game, you have the option to allow other game developers to create
plugins for your game. This can greatly extend the life of your product and open it to a wider
audience. Plugins can modify existing parts of your game or add completely new elements to it. You
could also use the plugin system yourself to distribute add-on packs for your game.

When you decide to have plugin support within your game, a “Plugins” folder will be created next time
you build your game with a file named “Plugin Data.txt” in it. Every category you selected will be
listed in this file. If you want to remove some files within a category without disabling the category
itself, (let say that you don’t want the user to be able to mess with some particular quest items) just
search for it in the list and remove it. This file is overwritten each time you build your game however
so you may want to do this only before a public release.

Note: If you check “Allow additional races/classes” but you don’t check the  “Show race/class
dialog” option in the “Misc” panel, the original  game will not let you pick any race.  However, if
someone develops a plugin that has a least one race or class in it, it will show the appropriate dialog
but only the races or classes from the plugins will show up. Pillars of Garendall, a game created with
Coldstone, works like this.

Check this box to allow other
developers to create plugins for
your game.

Check every category that you
want to be accessible to the
plugin developer. If you don’t
check the “Items” category for
example, the developer will
never know of their existence.
See the note below on
customized restriction.

Select if you want your game to
automatically load any available
plugin upon startup or kindly
ask the user what plugin he
wants to load.
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Miscellaneous options

The miscellaneous options panel lets you modify certain additional parameters in your game like the
name of the game, the default name of the player at creation, etc.

The default name of the
character when the player
starts a new game.

Show or hide the menubar
when the game starts. Please
note that you can modify the
status of the menubar at any
time using an action of type
“Menubar state”.

Screen mode: select “Window”
if you want your game to run in
a window or “Full screen” if you
want your game to fill the
whole screen. Select “Optional”
if you want to let the user
choose at first launch. The
dimension fields represent the
size of the window if in window
mode or the resolution to
switch at upon startup if in full
screen mode.
Screen depth: the number of
colors you want to set the
monitor to upon startup.
Thousands colors
recommended.

Player’s map display:
The picture that will represent the player in maps (at the beginning of the game). During the
game, you can modify this picture with an action of type “Player Map Icon”.

Gold map display:
The picture that will represent gold in maps (gold can be added to a map with the “Launch Item”
action type or dropped by an NPC after it has been defeated).

Click on the “Select…” button and select a picture file to set or change the current picture.

Specify which of the
standard creation dialogs
will be displayed at the
beginning of a new game.

It can be useful to remove
some dialogs when the
main character in the
game (the player) is fixed.

If you don’t check this
option, the engine will
ignore any “Fade
effect” action. Useful
for debugging
purposes.

The memory allowed for your
game. This is different for all
games since it highly depends
on how many things you
actually put in your game.

The name of your game. When the game is compiled, the
final application will have this name.

The four-character code that
will identify your Coldstone
game as a unique Macintosh
application.
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Plugin development

A Coldstone game developer has the option to enable plugin support in his game which means that other
developers (like you) could use Coldstone to develop add-ons to an existing game. This section describes how
to create such plugins but will assume that you have a certain knowledge of the principles behind Coldstone
(refer to the previous sections of this document).

Starting a new plugin project

Before starting to modify an existing game, you must create yourself a new plugin project, which is
very similar to an empty game. To do so, follow the exact same steps that you would for creating a
new empty game. Select the “Create new game” command under the “File” menu. The Coldstone
Game Wizard will appear and ask you where to save your new project. Press the “Select…” and
choose a destination folder. You will then be prompted to select your game style from the list. Select
“Plugin” from the list and follow the instruction to the end. You new project is empty with the
exception of an event named “Plugin_DebugInfos.cet”. This event is linked with a “Show plugin debug
infos” command added to the file menu and a global keydown event linked to the “d” key. This event
is automatically added so that you can play the game that you want to modify and gather useful
information about it at any time by either pressing the “d” key18 or selecting the appropriate menu
command under the file menu19. You should remove it before releasing your plugin to the public.

Plugin development mode

Coldstone can either be in standard game development mode or in plugin development mode. To
switch to plugin mode, select the “Load plugin data…” command under the sub-menu “Game plugin”
of the “Project” menu. A dialog will prompt you to select the plugin data file. This file contains all the
information needed to modify an existing game and should be included with the game itself, in the
“Plugins” folder of the game folder. The file should be named “Plugin data”. Browse to the original
game directory and search for this file.

After you selected the plugin data file, Coldstone will switch to plugin development mode. You will see
that the usual arrow button (launch button) of the toolbar will change for the “Plugin load calls”
button (represented by a brass gear). You now have all the components of the original game virtually
loaded in your project20. If you create an event and add a “Call event” action type for example, all the
events in your plugin project plus all the events of the original game (if any are allowed by the
game’s creator) will appear in the list. You can do anything in your plugin except modifying the
layouts of the original game and some other game options. You will also notice that some menu
commands are not visible in plugin mode.

                                                
18 This may not always work if the creator of the original game disabled the “Use global keydown events” option in some locations
(see the “Location editor interface” section).
19 The menubar may not be visible if the creator of the original game hides it. You can however display it yourself using a “Menubar
state” action type within an event.
20 The creator of the original game can restrict those components so that you can’t access some key features of the game (like
special events or items) or hide an entire category of components.
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Plugin Load Calls

When in plugin development mode, you can add events that are to be executed when a specific
location is loaded called plugin load calls. You could for example, use those to modify an existing
map with a “Change map cell” action or a “Stamp control” action. You can edit those events by either
clicking on the button to the far right of the Coldstone toolbar or by selecting select the “Plugin load
calls…” command under the sub-menu “Game plugin” of the “Project” menu. This dialog will appear:

Compiling a plugin

To try your plugin, you must first compile it. Plugins need to be compiled in release mode, which
means that all the files in your plugin project will be compressed into one big data file. Select the
“Build release” command from the “Project” menu. Select the platform you want to build your plugin
for and press the “OK” button to validate the dialog. You will then be prompted to select the folder in
which to compile your plugin data. Browse to the original game folder and select the “Plugin” folder
(you can also compile it elsewhere and move the resulting files to this folder) to start the compilation
process. When the compilation will be completed, you will see a new folder with the name of your
plugin21 within the plugin folder of the original game.

Trying a plugin

To try your plugin, you must be certain that it has been compiled in release mode and put in the
“Plugins” folder of the original game. Launch the original game. The creator of the original game may
have selected the “Auto load all plugins” option which will result in your plugin being automatically
loaded upon startup. Otherwise, there will be a nice user-friendly dialog that will ask you which plugin
you want to load. Check yours from the list (do not only select it, mark the checkbox next to its
name) and validate the dialog. Now that your plugin is loaded, play the game and see if your changes
appear as you wanted to! Have fun.

                                                
21 You can change the name of your plugin in the “Plugin options” dialog, under the “Misc” tab.

Select the location that you want
to trigger an event from your
plugin. Only the locations from the
original game are displayed.

Select the event that you want to
be executed when the selected
location is opened in the game.
Only the events from your plugin
project are displayed.

The list of all the plugin load calls.
Use the “+” button to add the
selected event and location to the
list. Click the “-“ to delete the
select call from the list. Finally, use
the two arrow buttons to move
the calls up or down in the list.
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Release mode compilation

What is release compilation?

When you select the “Launch” (or “Build and Launch”) command from the “Project” menu, a stand-
alone application is created in the same folder as your game folder and executed. You could very well
package the whole stuff and distribute it to the world but everyone would be able to modify your
game data with Coldstone, which you don’t necessary want. Coldstone provides a way to package all
your game data files in one big, clean package. If you want to create a game for a different platform
than yours, such as Windows, you’ll also need to build a release version.

How to build a release version

Select “Build release” from the “Project” menu.  This dialog will appear:

Just check the platform you want to support (and why not check them all?  Coldstone will take care
of everything). The “Compress picture data” option will convert every  PCT file (Macintosh Picture
format) in PNG format.  This will reduce considerably the size of the resulting game but it won’t be
compressed as much if you use a format such as ZIP or SIT to distribute your final package to world.

When you’re done with the above, click OK. You’ll be prompted to select a destination folder for your
compiled game. Validate the dialog and look at the progress bar. When it is be finished, you’ll have a
stand-alone, ready to distribute game package in the destination folder you selected.

System requirements

A game compiled with Coldstone has the following typical minimum requirements:

Macintosh Classic compilation

PowerPC Macintosh
MacOS 8.1 or better
20MB RAM allocated to it
Drawsprocket
Quicktime 4+

This version of your game won’t work on OSX.

Macintosh Carbon/OSX compilation

MacOS 8.1 or better
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MacOS 10.0.4 or better
Drawsprocket
Quicktime 4+
CarbonLib to run under OS8.1+
20MB RAM allocated to it to run under OS8.1+

This version of your game will run under OS8, OS9 (needs carbonlib) and OSX.

Windows compilation

Pentium II 350Mhz or better
Windows 95, 98, ME, 2000, XP
64MB RAM
DirectX 8
Quicktime 4
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Troubleshooting

Help with common situations you might run into.

My license code is invalid, what can I do?
The license code you were sent is based on your name as you gave it to us when you registered.
Make sure that you are entering your name exactly as it appears on your registration confirmation.  If
you still have a problem with your license code not working, please get in touch with us, and we will
take care of the situation for you.

I’ve lost my license code, what can I do?
Ambrosia Software, Inc. maintains a database of registered users, so if you should happen to lose
your license code, simply email the name of the product and your full name to
lostcodes@AmbrosiaSW.com, and we will send your code to you.

I would like to do something in particular but I don’t know how, what can I do?
The best place to go for help on Coldstone is the Ambrosia Web Board.  Go to:
http://www.AmbrosiaSW.com/news/webboard/ and then click on the Coldstone board.  If you
register, and why not, it's free! you can post your question, where it will be read and soon answered,
by other developers like you.  You can also scroll through questions and answers already posted.
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Registration and Contact Info

How to pay for Coldstone and get in touch with Ambrosia.

Shareware?
Coldstone is distributed as Shareware.  You are permitted to use it on a trial basis for up to 30 days.
If you wish to continue using Coldstone beyond this period, you are expected to pay a registration
fee to obtain a license to use Coldstone.

After we have processed your registration, we will send you a license code that you enter to
complete the registration process.  This removes the shareware notices and personalizes your copy
of Coldstone.

Coldstone has a $40.00 registration fee.

For an additional $5.00 Coldstone can be purchased on CD, giving you a hard copy backup of your
installer.  The CD comes with additional graphic libraries, sounds, and music as well as sample
Coldstone games and other really cool stuff to help you out in your game development.

We don’t gouge you with absurd prices.  We don’t fool you into buying our software with slick
advertising.  What we ask is this:  if you like our products, support us by paying for them.  If you
don’t like our products, don’t use them (or better yet, tell us why you don’t like them, so we can
improve them).

Why should I register (pay for) Coldstone?
We’re attempting to offer high quality products at a low price on a “try before you buy basis.”
Supporting us by registering Coldstone — assuming you like it — is the only way you can ensure that
we will continue to produce more high quality software distributed as shareware.

Beyond that, you will receive a license code that removes the shareware notices and personalizes
Coldstone with your name, giving you a legal copy on your Macintosh. You’ll also be able to distribute
your games to the world and even submit your product to Ambrosia Software … who knows, you may
just create the next Ambrosia big hit!

Registering Your Copy of Coldstone
Ambrosia’s Register Coldstone application allows you to easily register Coldstone using your choice of
several different methods. Simply click on the Register... button that appears when you launch
Coldstone. This will launch the Register Coldstone application. You can also double-click the Register
Coldstone icon from the Finder.

Ambrosia Software accepts all major credit cards (Visa, Mastercard, Discover and American Express).
A credit card can be used to register by WWW, email, fax, phone, or postal mail. You can also send a
check or money order to the address that appears below. Ambrosia Software also accepts purchase
orders if your organization requires them. All of these options are available in the Register Coldstone
application.

The Register Coldstone application is used to register Coldstone and enter your license code. This
application should not be thrown out or moved, even after you’ve registered, in case you need to
enter your code again.

About Ambrosia Software, Inc.
Ambrosia Software, Inc. is a small company dedicated to bringing you quality software, excellent
support, and innovative ideas all at a reasonable cost. We give you commercial-quality software at a
fraction of the price, with the added convenience of being able to try out the software before you
pay for it.
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Ambrosia distributes software on numerous electronic information services, as well as via user groups
and approved public domain distributors. Of course, you can always obtain our products directly from
us as well. You are given a 30 day free license to evaluate any of our software; after the 30 days
have passed, you are expected to send the appropriate registration fee to us for processing.

Ambrosia creates personal productivity tools that make using your Macintosh a more enjoyable
experience, as well as anti-productivity tools (games) which make your Macintosh just plain fun.

Support Forums
The latest versions of all our products are always available in the Ambrosia Software forums on the
following services:

      • America Online: While you are signed on AOL, choose Keyword... from the GO TO menu, type
FILESEARCH, and hit the return key.

      • CompuServe:  While you are signed on CompuServe, use GO word AMBROSIA to reach the Mac
Vendor D area, where Ambrosia Software, maintains a forum.

      • Internet: Visit our web site at http://www.AmbrosiaSW.com/ or our ftp site at
ftp://ftp.AmbrosiaSW.com/

      • Hotline: Visit our Hotline server at hotline://hotline.AmbrosiaSW.com/

You can now get all of our products on one CD.  This CD contains unregistered versions of all of our
games and utilities, plus lots of extra goodies.  You can order this CD from our web site at
http://www.AmbrosiaSW.com/Ware/ or you can call our toll free number 1-800-231-1816.  This
number is available from 9AM - 5:30PM EST, Monday through Friday.

Contact Information
Please feel free to get in touch with us using any of the following methods:

Ambrosia Software, Inc.
PO Box 23140
Rochester, NY 14692

Tel:  716.325.1910 (technical support)
800.231.1816 (orders only)

Fax:  716.325.3665

America Online:  AmbrosiaSW
CompuServe:  74777,1147
GEnie:  AmbrosiaSW
Internet:  help@AmbrosiaSW.com (technical support)

register@AmbrosiaSW.com (orders only)
lostcodes@AmbrosiaSW.com (lost license codes only)
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APPENDIX A – File formats

Coldstone supports various media formats.

Image formats

Some image formats support a custom resolution. Coldstone only supports the standard resolution
equal to 72ppi (pixel per inch).  If the resolution is different, you may not have any problem loading
it in the editor but it can cause very strange effects in the final game. If your game experiences some
problems loading a specific map, check the pictures used by it (remember, 71.9ppi is not 72ppi!).

Format Extension Notes

Mac Picture PCT Coldstone only supports the standard RLE for picture
compression (no Quicktime compression). Using this format can
result in bigger data files but will  be compressed at a higher
ratio if you stuff it for internet distribution.

JPEG JPG Only use this format for pictures that don’t need any
transparency. This format is destructive so some pure white
pixels may be slightly modified.

PNG PNG Use this format to create translucent images. Add an alpha
channel to create a transfer mask for the original image.

Bitmap BMP The standard Windows raw image format. Not recommended
since it uses a lot of disk space. You should use PCT or PNG for a
non-destructive format instead.

Sound formats

Coldstone uses a high-speed cross-platform sound player.  It actually supports only the AIFF sound
format with IMA encoding and mono channel. There is SoundApp, a very good Macintosh
application available out there that can help you easily convert sounds in this format.

Music and movie formats

Coldstone uses the Quicktime technology to play music and movies. Quicktime supports a wide
variety of formats including but not limited to AIFF, MPEG, and MP3. For the complete list of all the
file formats supported by Quicktime, you should visit:

 http://www.apple.com/quicktime/specifications.html.


